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ВСТУП 

Освітня компонента «Комп'ютерна хімія» вивчається 

здобувачами першого (бакалаврського) рівня вищої освіти на 

четвертому курсі та відповідає освітньо-професійній програмі 

Хімія.  

 

КРИТЕРІЇ ОЦІНЮВАННЯ ЗАНЯТЬ 

Оцінювання здобувачів вищої освіти здійснюється 

відповідно до «Положення про критерії та порядок оцінювання 

навчальних досягнень здобувачів вищої освіти Житомирського 

державного університету імені Івана Франка згідно з 

Європейською кредитною трансферно-накопичувальною 

системою» 

https://zu.edu.ua/offic/ocinjuvannya_zvo.pdf. 

Оцінювання навчальних досягнень здобувачів вищої 

освіти за всіма видами навчальних робіт проводиться за 

поточним, модульним та підсумковим контролем. 

Кожен здобувач вищої освіти має виконати обов’язкові 

завдання, передбачені інструктивно-методичними матеріалами 

до лабораторних занять, методичними рекомендаціями до 

організації самостійної роботи здобувачів вищої освіти, 

силабусом, навчальною та робочою програмою освітньої 

компоненти. 

Результати навчальної діяльності здобувачів вищої освіти 

оцінюються в балах, відповідно до виду діяльності. Визначений 

мінімум балів, який необхідно набрати для отримання заліку 

зазначений в робочій програмі навчальної дисципліни. 

Критерії оцінювання 

 

№ Лабораторна 

робота 

Т ТО ЛР Д 

15 25 50 10 

1 №1     

2 №2     

3 №3     

4 №4     

5 №5     

https://zu.edu.ua/offic/ocinjuvannya_zvo.pdf


6 

6 №6     

7 №7     

8 №8     

9 №9     

10 №10     

11 №11     

12 №12     

13 №13     

14 №14     

15 №15     

16 №16     

17 №17     

18 №18     

19 №19     

Рейтинг 100 

 

Види діяльності на занятті: Т – тестовий контроль знань; ТО – 

теоретичне опитування; ЛР – виконання лабораторної роботи; Д 

– презентація підготовленої доповіді. 
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Модуль 1. Сучасні методи комп’ютерної хімії та 

молекулярне моделювання 

Лабораторна робота №1 

Тема: Аналіз та візуалізація даних. Використання 

комп’ютерних технологій для розв’язування задач із хімії. 

Мета: ознайомитися з методикою використання електронних 

таблиць Excel для розв’язування вправ та задач з хімії та під час 

обробки великої кількості експериментальних даних у 

професійній діяльності хіміка.  

Основні поняття: електронні таблиці, масова частка 

речовини, електронна поляризація, густина розчину, графічна 

інтерпретація даних, автоматизація розрахунків. 

План заняття: 

1.   Організаційний момент. 

2. Тестовий контроль знань здобувачів вищої освіти. 

3. Теоретичне опитування за планом самостійної роботи. 

4. Виконання лабораторної роботи. 

5. Презентація підготовлених повідомлень здобувачами 

вищої освіти. 

Інструкція до виконання: 

1. Тестовий контроль знань 

Опрацюйте запропоновані літературні джерела та 

підготуйтесь до індивідуального тестування за основними 

поняттями теми. 

2. Теоретичне опитування за планом самостійної роботи 

Самостійно опрацюйте запропоновані контрольні 

запитання/завдання та підготуйтеся до усного виступу та 

співбесіди за ними. 

Контрольні запитання/завдання  

1. Які типи задач з хімії доцільно вирішувати за допомогою 

Excel? 

2. Як правильно організувати таблицю розрахунків у 

середовищі MS Excel? 

3. Які переваги автоматизації обчислень для хіміка-практика? 

4. Що таке електронна поляризація і від чого вона залежить? 
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5. Яка залежність між показником заломлення та 

концентрацією розчину? 

6. Поясніть, чому рекомендується записувати розмірності 

окремим стовпцем при розрахунках. 

7. Яка користь від побудови графіків у дослідницькій та 

експериментальній хімії? 

8. Чим відрізняється використання формул у Excel від ручних 

розрахунків? 

 

3. Виконання лабораторної  роботи 

Теоретичні відомості 

Використання електронних таблиць Excel дозволяє 

організовувати роботу з базами даних, вводити математичні 

формули, використовувати вбудовані функції, представляти дані 

в графічному вигляді, здійснювати графічну інтерпретацію 

розрахунків, вирішуючи, в тому числі, дидактичні задачі. Це 

особливо важливо в професійній підготовці майбутнього 

спеціаліста, коли професійні методичні знання починають 

формуватися в процесі освоєння спеціальних дисциплін. Окрім 

цього, розв’язання задач за допомогою електронних таблиць 

Excel сприяє поглибленому вивченню теоретичних основ хімії, 

інтеграції хімічних і математичних знань, формування 

інформаційної культури, а також дає великі можливості для 

реалізації міждисциплінарних зв'язків. 

Нижче наводяться приклади використання MS Excel для 

розв’язання деяких розрахункових задач з хімії та демонстрації 

різних можливостей електронних таблиць. 

Задача: До 300 г розчину калій нітрату з масовою часткою 

солі 30 % долили 200 мл води. Знайдіть масову частку солі (%) в 

утвореному розчині. 

Розв’язання: Для визначення складу розчину в масових 

частках у таблицю Excel вводяться: вихідні дані (заносяться в 

стовпці А і В) 

Увага! Для уникнення помилок при розрахунках та з метою 

взаємоузгодження величин рекомендовано в окремий стовпець 

(С) писати їх розмірності. 
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Розраховуємо масу калій нітрату у розчині, використавши 

формулу для знаходження масової  частки розчиненої речовини: 

 

 

При цьому в комірку В4 внесемо формулу В4=(В1/В2)/100, де 

В1 та В2 – адреси комірок з вихідними даними. 

 
Далі розраховуємо масу новоутвореного розчину KNO3. Для 

цього у В5 внесемо В5=В1+В3*1, де 1 г/мл густина води. 

%100
)нур(m

.)р.р(m
.)р.р( 

−
=
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Визначаємо масову частку солі (%) в новоутвореному 

розчині: В6=(В4/В5)*100. 

 
У створеній таким чином моделі можна розв’язувати й інші 

типові задачі змінюючи лише вихідні дані. Відповідь Excel 

розрахує автоматично згідно введених формул.  

 Задача: Під час експериментальних досліджень розчинів 

цукру рефрактометром встановлено значення показника 

заломлення світла (n). Використайте отримані результати з 

таблиці та встановіть залежність показника заломлення та 

електронної поляризації (R) від масової частки розчинів. 

m 

(цукор) 

m 

(H20) n 

V, 

мл 
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8,534 40,116 1,339 50 

12,114 39,3 1,3405 50 

9,70 13,50 1,343 25 

27,8285 15,944 1,349 50 

15,175 5,921 1,353 25 

19,238 1,017 1,355 25 

  !!!Електронна поляризацiя – зміщення електронів, атомів 

відносно їх ядер під дією випромінювання на 1 моль речовини. 

 

Розв’язання: У Excel створимо новий лист та введено 

отримані дані в таблицю (стовбці А-D) при цьому за допомогою 

вкладки «збільшити/ зменшити розрядність» округліть дані до 

сотих. 

 
Оскільки, електронну поляризацію розраховують за 

формулою:   

Розрахуємо масу розчину (стовбець Е) та густину (F) за 

формулами Е=А+В, F=E/D відповідно. Зверніть увагу, що після 

розрахунку значень для першого розчину масу та густину інших 

можна розрахувати автоматично: 

✓ в першу клітинку (Е2) записати потрібну формулу і 

натиснути Enter; 
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✓ після появи розрахованого по формулі значення 

навести курсор в нижній правий кут комірки (Е2); 

✓ натиснути на хрестик і, утримуючи його, 

протягнути формулу в потрібному напрямку – типовий 

обрахунок буде виконано. 

 
Аналогічно обраховуємо масові частки досліджуваних 

розчинів G=(A/E)*100. 

Для обрахунку електронної поляризації H=(((C^2)-

1)*342)/((C^2+2)*F), де 342 молярна маса сахарози. 

 
Побудовані згідно проведених розрахунків графіки 

дозволяють стверджувати, що зі збільшенням масової частки 

показник заломлення та електронна поляризація зростають, а 

залежність між величинами є прямою. 
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Застосування описаної методики дає можливість студенту, 

загострити свою увагу на хімічному сенсі задачі, що 

розв’язується, не відволікаючись на математичні розрахунки. 

Запропонована методика може бути корисною для обробки 

великої кількості експериментальних даних та може бути 

використана при виконанні лабораторних та кваліфікаційних 

робіт з хімії. 

Завдання до лабораторної роботи 

Середній склад деяких промислових газів (в об’ємних %), 

після видалення з них хімічних продуктів, приведено в таблиці: 

 CO H2 N2 CO2 CH4 

а) повітряний газ 33,5 1,0 64,5 0,5 0,5 

б) водяний газ 39 49 5 6 1 

в) доменний газ 27 8 51,4 12 1,6 

г) коксовий газ 6,8 57 7,7 6 22,5 

Розрахуйте парціальний тиск кожного з газів при 

нормальному атмосферному тиску і масу 1 м3 газу при 25 °C. 

Виразіть склад газового розчину в масових частках. 

Роботу виконувати згідно варіантів (де варіант – номер 

комп’ютера). 

Речовина Варіант 

а) повітряний газ 1, 5, 9, 13 

б) водяний газ 2, 6, 10, 14 

в) доменний газ 3, 7, 11, 15 

г) коксовий газ 4, 8, 12 
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Порядок виконання роботи 

1. Створіть новий документ Excel для введення й обчислення 

складу газової суміші. Назва документа – номер 

варанта_прізвище ім’я (1_Чайка Микола). 

2. Створіть таблицю 1 відповідно до свого варіанту за 

зразком: 

 
Перевірте сумарне значення об’ємних часток складових 

газової суміші. 

3. Знайдіть парціальні тиски складових 1 м3 газу при 

атмосферному тиску та оС (273 К). Використовуйте для 

обрахунків формулу: P (парц) = P1*V1/Vзаг. Дані внесіть до 

таблиці 2. Зверніть увагу: загальний тиск суміші газів = 101325 

Па! 

 
4. Для обрахунку маси 1 м3 газу створіть таблицю 3 зі 

значеннями молярної маси кожного з газів суміші. 

 
5. Використовуючи рівняння Менделєєва-Клапейрона, 

знайдіть кількість речовини кожного з компонентів суміші (дані 

внести до таблиці 4). Використовуйте при обрахунку знайдені в 

табл. 2 значення тисків. 

 
6. Згідно значень молярних мас (табл. 3) знайдіть та запишіть 

до таблиці 5 масу кожного з компонентів суміші. 



15 

 
7. Виразіть склад газового розчину в масових частках (табл. 

7). Зверніть увагу на суму масових часток газоподібних 

компонентів. 

 
Увага! Всі дані, що використовуються під час обрахунків 

повинні бути внесеними до Excel, а заокруглення – «автоматичне, 

до сотих». 

Завдання може бути виконано й за іншим алгоритмом. 

Обов’язкова умова – представлення всіх етапів у табличному 

процесорі Excel. 

8. Відправте файл виконаної лабораторної роботи на е-пошту 

викладача, у темі листа обов’язково вказіть прізвище та номер 

лабораторної роботи. 

 

4. Презентація підготовлених повідомлень здобувачами 

вищої освіти 

За бажанням оберіть запропоновану тему повідомлення з 

теми, яку вивчаєте. Підготуйте усний виступ та електронну 

презентацію з теми. Будьте готові виступити перед аудиторією. 

 

Теми повідомлень: 

Можливості електронних таблиць для хімічного аналізу: MS 

Excel як інструмент лабораторної роботи. 

Графічна візуалізація експериментальних результатів у хімії: 

підхід через Excel. 

Обчислення масових часток і концентрацій у розчинах: цифрові 

технології в хімічній освіті. 

Автоматизація хімічних розрахунків у лабораторії: ефективність 

та точність. 
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Міждисциплінарний підхід у хімії: як Excel поєднує математику, 

фізику й інформатику. 

Аналіз похибок у хімічному експерименті з використанням 

електронних таблиць. 

Застосування Excel у фармацевтичному, екологічному та 

харчовому хімічному аналізі. 

 

Рекомендована література 

Основна: 

1. Олексеюк С.Т., Проц Д.І., Супрунович С.В. Прикладні 

комп’ютерні програми для аналітичної та органічної хімії. – 

Луцьк: РВВ „Вежа” ВДУ ім. Лесі Українки, 2004, – Ч.І. – 82 с. 

2. Бондар О.С. Практикум з комп’ютерної хімії. Навчальний 

посібник. Чернігів: ЧНПУ, 2017. – 68 с. 

3. Туровський М.А., Туровська О. М. Практичний курс 

комп’ютерної структурної хімії. Навчальний посібник. Донецьк: 

ДонНУ, 2004. 131 с. 

Додаткова: 

1. Jensen F. Introduction to Computational Chemistry. – London, 

1999. – 429. 

2. Коновалова С.О. Комп’ютерні та інформаційні технології в 

хімії: стислий конспект лекцій. – Краматорськ: ДДМА, 2020. – 80 

с. 

3. Кулігін М.Л. Комп’ютерна хімія: конспект лекцій. – Херсон: 

ХНТУ, 2013. – 80 с. 

 

 

 

 

Дата                                                      Підпис викладача 
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Лабораторна робота №2 

Тема: Аналіз та візуалізація даних. Діаграми. Аналіз даних, 

поданих на діаграмах та графіках. 

Мета: формування уявлень про способи візуалізації 

числових даних у вигляді діаграм та графіків, відпрацювання 

навичок застосування цих способів при вирішенні конкретних 

завдань з хімії.  

Основні поняття: електронні таблиці, діаграма, лінія 

тренда, гістограма, кругова діаграма, легенда діаграми, область 

побудови діаграми. 

План заняття: 

1.   Організаційний момент. 

2. Тестовий контроль знань здобувачів вищої освіти. 

3. Теоретичне опитування за планом самостійної роботи. 

4. Виконання лабораторної роботи. 

5. Презентація підготовлених повідомлень здобувачами 

вищої освіти. 

Інструкція до виконання: 

1. Тестовий контроль знань 

Опрацюйте запропоновані літературні джерела та 

підготуйтесь до індивідуального тестування за основними 

поняттями теми. 

2. Теоретичне опитування за планом самостійної роботи 

Самостійно опрацюйте запропоновані контрольні 

запитання/завдання та підготуйтеся до усного виступу та 

співбесіди за ними. 

Контрольні запитання/завдання  

1. Що таке діаграма і яку роль вона відіграє у візуалізації 

числових даних? 

2. Які типи діаграм реалізовані в MS Excel? 

3. У чому відмінність між гістограмою та графіком? 

4. Як створити графік у Excel на основі таблиці з даними? 

5. Як додати другу вісь Y до графіка і навіщо це роблять? 

6. Що таке лінія тренду? Яку інформацію вона відображає? 

7. Який тип діаграми доцільно використовувати для 

відображення відсоткового складу? 
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3. Виконання лабораторної  роботи 

Теоретичні відомості 

Діаграма – це графічне зображення, у якому співвідношення 

між числовими значеннями даних відображають за допомогою 

геометричних фігур. Така візуалізація даних більш наочна, ніж 

числові записи та суттєво покращує їх розуміння та сприйняття. 

Діаграми в МS Excel –  динамічні, тобто змінюючи дані в 

електронній таблиці, автоматично змінюються й діаграми. Excel 

дозволяє побудувати діаграми одного з 11 типів: стовпчаста, 

лінійчата, секторна, гістограма, графік та інші. Кожний тип має 

декілька видів, які можна переглянути, у вкладці Вставка в пункті 

«Діаграми». 

Для побудови діаграми спочатку виділіть діапазон клітинок з 

даними, за якими потрібно побудувати діаграму. Важливо, щоб 

рядки та стовпці були підписані, адже вони автоматично будуть 

вставлені на діаграму як підписи осей та легенд. Далі натисніть 

вкладку Вставка та в пункті Діаграми оберіть серед списку 

діаграму потрібного типу. 

 
Після виконання такого алгоритму на листку поряд з 

електронною таблицею буде побудовано діаграму, основні 

властивості об'єктів якої будуть встановлені за замовчуванням. 
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Основних типів діаграм в Excel –  одинадцять, серед яких 

найбільш використовувані: 

• Гістограма - на основі даних, які впорядковано в рядки чи 

стовпці, можна побудувати гістограму. Гістограма 

ілюструє порівняння окремих елементів. Зазвичай у 

гістограмі категорії – на осі абсцис, а значення – на осі 

ординат. Гістограми будують, коли підписи осей доволі 

довгі; представлені значення – часові проміжки. 

• Графік. Показує тенденцію зміни значень даних. На осі 

абсцис автоматично відкладають номери точок даних, а на 

осі ординат – значення чисел, за якими будуєть графік. 

• Кругова. На основі даних, які упорядковано в одному 

рядку або стовпці, можна побудувати кругову діаграму. 

Вона показує розміри елементів з ряду даних пропорційно 

до загальної суми елементів. Дані у круговій діаграмі 

відображаються у вигляді відсотків від цілого круга. 

Якщо область діаграми виділити, то на головній панелі 

з'являється тимчасовий розділ «Інструменти для діаграм» з 

трьома вкладками: «Конструктор», «Макет» та «Формат». 

На вкладці «Макети діаграм» можна вибрати потрібний 

макет, що має свій набір об'єктів діаграми та особливості їх 

розташування. 

У вкладці «Стилі діаграм» наявні різні стилі оформлення 

діаграм. 

Вкладка «Дані» дозволяє поміняти дані по осях (взаємно) 

кнопкою «Рядок/стовбець» та змінити діапазон даних 

представлених на діаграмі  кнопкою «Вибрати дані». 

Вкладка «Тип» дозволяє змінити тип та вид діаграми а також 

зберегти тип та форматування в якості шаблону. 

У вкладці «Макет» в групі «Підписи» можна створювати та 

редагувати елементи діаграми (додавати, видаляти та змінювати 

розміщення назви діаграми, її осей, легенд). 

Вкладка «Вісь» зміну форматування та розмітки осей а також 

використовувати логарифмічну шкалу. Крім того можна 

додавати/прибирати лінії сітки. 
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У вкладці «Фон» можна змінювати параметри області 

побудови діаграми (її колір або стиль границь і т.д.). 

Вкладка «Аналіз» дозволяє додавати або прибирати лінію 

тренду, яка призначена відображати тенденції в існуючих даних.  

Важливою функцією при побудові графіків/діаграм є 

додавання другої осі. Тому якщо дані, за якими побудовані 

графіки, сильно відрізняться один від одного і вако побачити 

зміну параметру (несуттєвого) для відображення його зміни 

можна додати додаткову вісь Y. Для цього потрібно: 

✓ побудувати звичайний графік; 

✓ перейти на графік та натиснути правою кнопкою 

миші на даних лінії, де потрібно додати другу вісь; 

✓ обрати пункт «Формат ряду даних» та встановити 

перемикач на положенні «По додатковій осі»; 

Ряди даних у Exсel можна використовувати для 

прогнозування явищ чи процесів. 

Наприклад: у лабораторії протягом півроку фіксували таку 

динаміку використання етанолу (л) в якості органічного 

розчинника під час синтезів: 

Квітень Травень Червень Липень Серпень Вересень 

60,7 60,6 60,4 60,1 60 59,7 

Дослідників цікавить його використання протягом наступних 

місяців, якщо кількість синтезів не змінюватиметься. 

Такий прогноз  можна отримати через побудову лінії тренду 

в Excel. 

Лінія тренду – це лінія, вздовж якої розташовані на діаграмі 

точки, що зображають дані представлені у певному ряду. 

Для побудови потрібно за даними таблиці побудувати 

точкову діаграму: Вставка – Точкова – Точкова діаграма лише 

з маркерами; далі Макет – Лінія тренду – Прогнозована пряма 

з трендом. 
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За цією лінією можна передбачити, що використання 

етилового спирту в жовтні складатиме  - 59,5 л, а в листопаді – 

59,3 л. 

Якщо обрати діаграму та натиснути Макет – Лінія тренду – 

Інші параметри лінії тренду, то з’явиться вікно «Формат ліні 

тренду» де можна: 

➢ обрати інший період (кнопки «вперед на» та «назад на»); 

➢ вказати назву лінії тренду в легенді; 

➢ обрати іншу функцію, яка задаватиме лінію тренду; 

➢ від форматувати лінію тренду. 

 

Завдання до лабораторної роботи: 

Відповідно до номеру варіанту у МS Excel створити таблицю 

для проведення розрахунків.  

 

Варіант x dx y a b c d 

a (1,6,11) 0,1 0,5 
 

17,1 -0,8 0,05 12,2 

b (2,7,12) 6,2 -0,3 

 

0,2 -2,1 1,1 0,1 

c (3,8,13) 4 0,8 
 

0,1 1,3 2,1 0,4 

y = -0,2029x + 60,96
59,2

59,4

59,6

59,8

60

60,2

60,4

60,6

60,8

61

0 1 2 3 4 5 6 7 8 9

Ряд1

Лінійна (Ряд1)
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d (4,9,14) 0,2 0,3 
 
1,6 0,2 1,7 0,85 

e 

(5,10,15) 
9,2 -0,2 

 
-1,4 1,2 2,3 -0,2 

 

1. Створіть новий документ Excel, де назва документа – номер 

варіанта_прізвище ім’я (1_Чайка Микола). Перший стовпець  

таблиці заповніть номерами від 1 до 20. 

2. Другий стовпець – значення аргументу x заповнити 

числами (xi), що отримані за правилами (xi+1 = xi + dx, де dx – крок 

прогресії). Використати для цього автозаповнення. 

3. В третьому стовпці – результати обчислення функції y = 

f(x)  (згідно з варіантом) для всіх значень xi з попереднього 

стовпця. Константи для формул (a, b, c, d) повинні бути 

представлені абсолютними посиланнями. 

4. В наступні стовпці таблиці послідовно ввести результати 

обчислення значень функцій: f1 = x2, f2 = 1/x, f3 = y2 і f4 = 1/y (для 

усіх значень x та у). 

5. Використовуючи значеннями x і у (за потреби і значення 

1/x, y2, x2, 1/y), обчислити в наступних стовпцях значення функцій 

u = u (x) та  v = v(у). Парні варіанти рахують функцій u та v за 

формулами  u = 1/x + x2 - x/3;    

v = y2 - 1/y, непарні варіанти – за формулами u = x2 - 1/x;  v = 

1/y + y2 -  у/3. 

6. В наступний стовпець ввести значення функції s, 

обчисливши її за формулою s = u + v. 

7. Під кожним стовпцем таблиці (крім стовпця з порядковими 

номерами) знайти суму, максимальне, середнє та мінімальне 

значення. 

8. Побудувати графіки двох функцій від одного аргументу 

відповідно до варіанту. Побудувати спільний графік для цих 

функцій. 

 

Варіант Завдання 

a (1,6,11) графіки функцій: y = f(x), y2 = f(x) 

b (2,7,12) графіки функцій: y = f(x), y2 = f(x) 
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c (3,8,13) графіки функцій: y = f(x), y2 = f(x) 

d (4,9,14) графіки функцій: y = f(x), y2 = f(x) 

e (5,10,15) графіки функцій: y = f(x), u = f(x) 

 

9. Побудувати 2 варіанти гістограм (звичайної або об'ємної). 

Варіант Завдання 

a (1,6,11) 

гістограми за даними рядків таблиці: 1) з 

максимальними значеннями; 2) з середніми 

значеннями. 

b (2,7,12) 

гістограми за даними рядків таблиці: 1) з 

максимальними значеннями; 2) з середніми 

значеннями. 

c (3,8,13) 

гістограми за даними рядків таблиці: 1) з 

максимальними значеннями; 2) з середніми 

значеннями. 

d (4,9,14) 

гістограми за даними рядків таблиці: 1) з 

максимальними значеннями; 2) з середніми 

значеннями. 

e (5,10,15) 

гістограми за даними рядків таблиці: 1) з 

мінімальними значеннями; 2) зі значеннями 

сум стовпців 

 

10. Побудувати 2 варіанти кругової та (або) кільцевої діаграм 

(плоска або об'ємна). 

 

Варіант Завдання 

a (1,6,11) 
1) з мінімальними значеннями; 2) зі значеннями 

сум стовпців. 

b (2,7,12) 
1) з мінімальними значеннями; 2) зі значеннями 

сум стовпців. 

c (3,8,13) 
1) з мінімальними значеннями; 2) зі значеннями 

сум стовпців. 

d (4,9,14) 
1) з мінімальними значеннями; 2) зі значеннями 

сум стовпців. 

e (5,10,15) 
1) з максимальними значеннями; 2) з середніми 

значеннями. 
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11. Використовуючи лінію тренду спрогнозуйте добування 

природного газу в Україні через 3 роки, використовуючи для 

прогнозу дані наведені в таблиці: 

2015 2016 2017 2018 2019 

19,9 20,1 20,5 21 20,9 

Виведіть математичне рівняння, що дозволить вираховувати 

добування природного газу в майбутньому. 

12. Відправте файл виконаної лабораторної роботи на е-

пошту викладача, у темі листа обов’язково вказіть прізвище та 

номер лабораторної роботи. 

 

Всі зображені графіки та діаграми повинні мати назву, 

«легенду», на осях графіків вказати функцію та аргумент 

Приклад оформлення таблиці з розрахунками 
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4. Презентація підготовлених повідомлень здобувачами 

вищої освіти 

За бажанням оберіть запропоновану тему повідомлення з 

теми, яку вивчаєте. Підготуйте усний виступ та електронну 

презентацію з теми. Будьте готові виступити перед аудиторією. 

Теми повідомлень: 

Основні типи діаграм у MS Excel: призначення та приклади 

використання в хімії. 
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Графічна візуалізація експериментальних даних у хімії: аналіз і 

прогнози. 

Порівняння гістограми, графіка та кругової діаграми: коли і яку 

краще використовувати. 

Створення лінії тренду в Excel та її значення для хімічних 

досліджень. 

Використання подвійної осі на графіках: приклади з хімічних 

задач. 

Можливості аналітичних інструментів Excel для аналізу 

лабораторних даних. 

Побудова прогнозів у Excel: теорія та практика на прикладі 

витрати хімреактивів. 

Роль візуалізації даних у підготовці наукових презентацій та 

звітів з хімії. 

Рекомендована література 

Основна: 

1. Олексеюк С.Т., Проц Д.І., Супрунович С.В. Прикладні 

комп’ютерні програми для аналітичної та органічної хімії. – 

Луцьк: РВВ „Вежа” ВДУ ім. Лесі Українки, 2004, – Ч.І. – 82 с. 

2. Бондар О.С. Практикум з комп’ютерної хімії. Навчальний 

посібник. Чернігів: ЧНПУ, 2017. – 68 с. 

3. Туровський М.А., Туровська О. М. Практичний курс 

комп’ютерної структурної хімії. Навчальний посібник. Донецьк: 

ДонНУ, 2004. 131 с. 

Додаткова: 

1. Jensen F. Introduction to Computational Chemistry. – London, 

1999. – 429. 

2. Коновалова С.О. Комп’ютерні та інформаційні технології в 

хімії: стислий конспект лекцій. – Краматорськ: ДДМА, 2020. – 80 

с. 

3. Кулігін М.Л. Комп’ютерна хімія: конспект лекцій. – Херсон: 

ХНТУ, 2013. – 80 с. 

 

Дата                                                      Підпис викладача 
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Лабораторна робота №3 

Тема: Створення структурних формул молекул за допомогою 

програми Isis Draw. 

Мета: Ознайомитися з основними можливостями програми 

Isis Draw як засобу побудови структур органічних і неорганічних 

молекул. Навчитися створювати, редагувати, зберігати та 

експортувати молекулярні формули. Формувати навички 

використання візуального редактора для створення хімічних 

зображень та схем.  

Основні поняття: Isis Draw, хімічний редактор, робоче поле, 

інструментальна панель, SMILES, експорт. 

План заняття: 

1. Організаційний момент. 

2. Тестовий контроль знань здобувачів вищої освіти. 

3. Теоретичне опитування за планом самостійної роботи. 

4. Виконання лабораторної роботи. 

5. Презентація підготовлених повідомлень здобувачами вищої 

освіти. 

Інструкція до виконання: 

1. Тестовий контроль знань 

Опрацюйте запропоновані літературні джерела та 

підготуйтесь до індивідуального тестування за основними 

поняттями теми. 

2. Теоретичне опитування за планом самостійної роботи 

Самостійно опрацюйте запропоновані контрольні 

запитання/завдання та підготуйтеся до усного виступу та 

співбесіди за ними. 

Контрольні запитання/завдання  

1. Для чого використовують програму Isis Draw? 

2. Які основні інструменти містить панель редактора? 

3. Як побудувати бензольне кільце або аліфатичний 

фрагмент? 

4. Як змінити тип зв’язку (одинарний, подвійний, 

потрійний)? 

5. Як зберегти отриману структурну формулу? 

6. У яких форматах можна експортувати зображення? 
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7. Які переваги має використання Isis Draw у наукових 

публікаціях? 

8. Як вставити структурну формулу в документ Word або 

презентацію? 

 

3. Виконання лабораторної  роботи 

Теоретичні відомості 

Програма Isis Draw є одним із найзручніших хімічних 

редакторів для створення двовимірних зображень молекул. Вона 

дозволяє будувати структурні формули, вказувати атоми, зв’язки, 

функціональні групи, а також автоматично розставляє водні 

атоми, номери атомів, дозволяє обчислювати формули та маси. Її 

можливості широко використовуються в аналітичній, органічній 

та фармацевтичній хімії. 

Завдання до лабораторної роботи 

1) Підготовка до роботи 

Запуск програми: 

• Відкрийте програму Isis Draw (якщо встановлена, 

подвійним кліком по ярлику на робочому столі або через 

меню «Пуск»). 

• Дочекайтесь повного завантаження інтерфейсу. 

Ознайомтесь із головним вікном: 

• Робоче поле (Canvas): біла область для побудови 

структур. 

• Панель інструментів ліворуч: вибір типу атома, типів 

зв’язків, фрагментів кілець. 

• Меню зверху: «File», «Edit», «Structure», «Tools», «View», 

«Help». 

 

2) Побудова структур простих органічних молекул 

 

a) Побудова стурктури етанолу (CH₃CH₂OH) 

 

1. На панелі інструментів виберіть інструмент одинарного 

зв’язку (Single Bond). 

2. Клацніть у центрі робочого поля — з’явиться перший атом 
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(він за замовчуванням – вуглець, C). 

3. Потягніть мишу в будь-якому напрямку — з’явиться 

зв’язок і другий атом. 

4. Повторіть, щоб додати третій атом (отримуємо CH₃–CH₂–

). 

5. Виберіть інструмент для вставки гідроксильної групи –

OH: 

✓ Натисніть на другий атом (CH₂), клацніть правою 

кнопкою → Atom → O (кисень). 

✓ Потім додайте до O –H (аналогічно). 

Рекомендації: 

• Зайві атоми водню зазвичай автоматично додаються при 

збереженні структури. 

• Щоб змінити елемент – клацніть на ньому двічі або через 

праву кнопку миші → Atom → виберіть зі списку. 

 

b) Побудова циклічних сполук: бензол (C₆H₆) 

 

1. На панелі інструментів натисніть на іконку «6-членного 

кільця» (benzene ring). 

2. Клацніть на робочому полі — з’явиться шестикутник із 

чергуванням подвійних зв’язків. 

3. Щоб додати замісники (наприклад –CH₃ або –NO₂): 

✓ Виберіть відповідний атом зі списку → клацніть на 

будь-який атом кільця → вставте замісник. 

4. Щоб підписати назву — використайте меню Object → 

Text. 

 

c) Побудова функціональних груп та фрагментів: толуол 

1. Побудуйте бензольне кільце (як вище). 

2. Додайте до одного з атомів –CH₃: 

✓ Виберіть Carbon, клацніть на вільній валентності 

атома кільця. 

✓ Якщо треба, додайте водень або відредагуйте 

структуру. 
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Фрагмент ДНК (один нуклеотид): 

• Побудуйте фосфатну групу, дезоксирибозу (п’ятичленне 

кільце) та основний фрагмент (аденін, гуанін тощо). 

• Приєднайте ці елементи між собою (схематично). 

 

d) Побудова реакційних схем: естерифікація оцтової кислоти 

та етанолу 

1. Побудуйте структуру оцтової кислоти (CH₃COOH). 

2. Побудуйте етанол (CH₃CH₂OH). 

3. Побудуйте продукт — етилацетат (CH₃COOC₂H₅). 

4. Додайте умови реакції: 

✓ Меню → Object → Text, укажіть: H₂SO₄ (кат.), t° 

5. З’єднайте реагенти стрілкою: 

✓ Меню Structure → Reaction → Arrow, клацніть 

мишкою в напрямку від реагентів до продукту. 

 

3) Збереження та експорт результатів 

 

1. Щоб зберегти проєкт у робочому форматі (для 

редагування): 

✓ File → Save As → виберіть формат .skc 

2. Щоб експортувати зображення: 

✓ Edit → Copy As → Metafile or Bitmap 

✓ Відкрийте документ Word → натисніть Ctrl+V 

(вставити). 

3. Альтернатива: File → Export as Image (PNG, JPG) → 

виберіть якість і папку. 

 

Завдання до лабораторної роботи: 

Побудуйте та збережіть структури наступних сполук: 

1. Етанол (CH₃CH₂OH) 

2. Бензол (C₆H₆) 

3. Толуол (C₆H₅CH₃) 

4. Ацетон (CH₃COCH₃) 

5. Аспірин (ацетилсаліцилова кислота) 
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Збережіть кожну структуру у форматі .skc та .png або .jpg (для 

вставки у Word). 

 
Побудуйте структурні фрагменти: 

• Фрагмент ДНК (один нуклеотид) 

• β-каротин або вітамін C (за зразком) 

• Одна з амінокислот (наприклад, гліцин, аланін або лейцин) 

 
Створіть на одному полі реакційну схему естерифікації оцтової 

кислоти етанолом з умовами реакції. 

 

Звітність 

У звіт вставте: 

➢ Побудовані структури (5 молекул) 

➢ 1 реакційну схему 

➢ Пояснення до побудови (коротко: яка формула, що і як 

було додано) 

➢ Скриншот вікна програми з прикладом 

 

Індивідуальні завдання (на вибір): 

➢ Побудуйте власну реакцію з міжмолекулярною 

взаємодією (наприклад, конденсація або гідроліз). 

➢ Намалюйте структурну формулу молекули з вашої 

курсової роботи або дослідження. 

➢ Побудуйте імена та структури ізомерів бутанолу. 

 

Відправте файли виконаної лабораторної роботи на е-пошту 

викладача, у темі листа обов’язково вказіть прізвище та номер 

лабораторної роботи. 

 

 

4. Презентація підготовлених повідомлень здобувачами 

вищої освіти 

За бажанням оберіть запропоновану тему повідомлення з 

теми, яку вивчаєте. Підготуйте усний виступ та електронну 

презентацію з теми. Будьте готові виступити перед аудиторією. 
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Теми повідомлень: 

Програма Isis Draw як інструмент побудови структурних формул. 

Застосування Isis Draw у наукових публікаціях. 

Порівняння популярних хімічних редакторів: Isis Draw, 

ChemDraw, ChemSketch. 

Правила побудови молекулярних структур у комп’ютерних 

редакторах. 

Автоматизація оформлення лабораторних звітів за допомогою Isis 

Draw. 

Рекомендована література 

Основна: 

1. Олексеюк С.Т., Проц Д.І., Супрунович С.В. Прикладні 

комп’ютерні програми для аналітичної та органічної хімії. – 

Луцьк: РВВ „Вежа” ВДУ ім. Лесі Українки, 2004, – Ч.І. – 82 с. 

2. Бондар О.С. Практикум з комп’ютерної хімії. Навчальний 

посібник. Чернігів: ЧНПУ, 2017. – 68 с. 

3. Туровський М.А., Туровська О. М. Практичний курс 

комп’ютерної структурної хімії. Навчальний посібник. Донецьк: 

ДонНУ, 2004. 131 с. 

Додаткова: 

1. Jensen F. Introduction to Computational Chemistry. – London, 

1999. – 429. 

2. Коновалова С.О. Комп’ютерні та інформаційні технології в 

хімії: стислий конспект лекцій. – Краматорськ: ДДМА, 2020. – 80 

с. 

3. Кулігін М.Л. Комп’ютерна хімія: конспект лекцій. – Херсон: 

ХНТУ, 2013. – 80 с. 

 

Дата                                                      Підпис викладача 

 

 

Лабораторне заняття №4 

Тема: Модульна контрольна №1 «Сучасні методи 

комп’ютерної хімії та молекулярне моделювання» 

 

Обсяг вимог визначається програмою  
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Модуль 2. Пакети програм СhemOffice та HyperСhem, їх 

застосування 

Лабораторна робота №5 

Тема: Побудова структурних формул органічних речовин за 

допомогою спеціального редактора хімічних формул ChemDraw. 

Мета: Оволодіти базовими та розширеними навичками 

використання інструментів редактора ChemDraw для створення, 

редагування, конвертації структурних формул органічних 

речовин, у тому числі з використанням SMILES-коду, назв 

ІЮПАК та інструментів аналізу.  

Основні поняття: структурна формула, SMILES, шаблони 

(Templates), IUPAC, Convert Name to Structure, Clean Up Structure, 

Check Structure, властивості молекули. 

План заняття: 

1. Організаційний момент. 

2. Тестовий контроль знань здобувачів вищої освіти. 

3. Теоретичне опитування за планом самостійної роботи. 

4. Виконання лабораторної роботи. 

5. Презентація підготовлених повідомлень здобувачами вищої 

освіти. 

Інструкція до виконання: 

1. Тестовий контроль знань 

Опрацюйте запропоновані літературні джерела та 

підготуйтесь до індивідуального тестування за основними 

поняттями теми. 

2. Теоретичне опитування за планом самостійної роботи 

Самостійно опрацюйте запропоновані контрольні 

запитання/завдання та підготуйтеся до усного виступу та 

співбесіди за ними. 

Контрольні запитання/завдання  

1. Які інструменти використовують для побудови у ChemDraw? 

2. Що таке SMILES-коди і як вони застосовуються в ChemDraw? 

3. Які можливості надає функція «Convert Name to Structure»? 

4. Як перевірити валідність структури у ChemDraw? 

5. Які властивості молекули можна переглянути у вікні 

"Chemical Properties"? 
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3. Виконання лабораторної  роботи 

Теоретичні відомості 

ChemDraw від фірми Cembrige soft – один з найзручніших та 

найефективніших редакторів структур хімічних речовин. 

Програма допомагає створювати, редагувати та оформлювати 

хімічні формули, схеми, рівняння реакцій будь-якої складності. 

Крім того, в програмі реалізовано можливість зображувати 

проекції Фішера та Ньюмана, аналізувати властивості 

представлених речовин та виявляти помилки в їх структурі. 

Інтерфейс користувача ChemDraw дозволяє створювати 

структурні формули наступними способами: 

а) безпосереднє зображення при активуванні кнопки "Bond" 

для зображення хімічного зв'язку. Для вписування знаку 

хімічного елементу кінець зв'язку виділяють подвійним 

клацанням лівої кнопки мишки; 

б) генерація за назвою ІЮПАК. Активують функцію "Convert 

Name to Strukture"; 

в) використання формул заготовок (кнопки "Templates", 

"Acyclic Chain", "Rings"). 

При активній кнопці "Check Structure" програма перевіряє 

виділену молекулярну структуру на наявність помилок, а при 

активній кнопці "Clean Structure" – на відповідність параметрів 

молекули звичайним довжинам зв'язків і валентних кутів з 

автоматичним їх виправленням. 

ChemOffice містить велику базу даних за номенклатурою 

органічних сполук, що дозволяє легко вирішувати як прямі 

завдання: «назвати сполуку» (кнопка "Convert Strukture to Name"), 

так і зворотні: «написати структурну формулу за назвою» 

"Convert Name to Strukture". Тут важливо знайти розумний 

компроміс у використанні традиційних і нових форм навчання. 

 

1. Запуск програми та її налаштування. 

Запустити програму ChemDraw можна командою головного 

меню: "ПУСК – Программы – CS Chem Office – CS ChemDraw 

Pro". 
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Далі потрібно відкрити вікно налаштувань програми 

командою меню "File-Preferences"; для пункту "Units" встановити 

значення "cm", а для "Tolerance" – "5 pixels". Після цього слід 

натиснути кнопку "ОК" для підтвердження. 

Для візуальної зручності можна включити відображення 

лінійок в документі та координатної сітки. Для цього в меню 

"Tools" потрібно поставити відмітку навпроти пункту "Show 

Rulers". Для відображення координатної сітки можна поставити 

відмітку навпроти пункту "Show Crosshair" меню "Tools". 

 

2. Вивчення меню програми. 

Головне меню програми включає такі пункти: File, Edit, View, 

Object, Structure, Text, Curves, Color, Search, Window, Help (рис. 

1.1). 

 
Рис. 1.1. Вигляд головного меню редактора ChemDraw. 

 

File (Файл) дає можливість створювати документи ChemDraw, 

налаштовувати їх та зберігати (рис. 1.2). 

 
Рис. 1.2. Підпункт меню Файл редактора ChemDraw. 
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Edit (Правка) дає можливість працювати з фрагментами та 

структурами в цілому (вирізати, копіювати, вставляти, виділяти) 

(рис. 1.3). 

 
Рис. 1.3. Підпункт меню Правка редактора ChemDraw. 

Tools (Інструменти) – цей пункт меню допомагає 

налаштувати робочий стіл для роботи в ChemDraw відповідними 

інструментами та встановити деякі параметри зображення 

формул (фіксовані довжини зв’язків, фіксовані кути тощо) (рис. 

1.4). 

Рис. 1.4. Підпункт меню Інструменти редактора ChemDraw. 
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Object (Об’єкт). За допомогою цього пункту меню 

користувач має можливість зручно для себе розмітити об’єкти на 

сторінці, повернути їх, відобразити тощо (рис. 1.5). 

 
Рис. 1.5. Підпункт меню Об’єкт редактора ChemDraw. 

 

Structure (Структура). Цей пункт меню дає можливість 

користувачу працювати зі структурою сполуки, варіювати її 

вигляд, аналізувати її, показувати властивості, виправляти 

помилки, а також за назвою сполуки генерувати її структуру 

"Convert Name to Strukture" та навпаки "Convert Strukture to Name 

" (назви потрібно вказувати англійською мовою) (рис. 1.6). 

 
Рис. 1.5. Підпункт меню Структура редактора ChemDraw. 
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Text (Текст). Цей пункт меню дає можливість форматувати 

текстові фрагменти (змінювати вигляд та тип шрифту, 

вирівнювати текст тощо). 

Curves (Криві). Опції цього пункту активуються після 

зображення кривих у документі. Користувач може змінювати їх 

вигляд та форму. 

Color (Колір) – цей пункт меню дає можливість змінювати 

колір фону та шрифту. 

Window (Вікно) – дає можливість працювати з декількома 

вікнами одночасно, зручно розміщувати їх на робочому столі. 

Help (Допомога) – містить загальні відомості та пояснення 

різних прийомів роботи з редактором. 

 

Завдання до лабораторної роботи: 

a) Зображення формул ациклічних хімічних сполук. 

1. Намалюйте структурні формули органічних речовин 

використовуючи наявні інструменти з меню «Tools» відповідно 

до варіанту: 

 

Варіант Органічні речовини 

1, 10, 15 
Пропан; 2,3-диметилбутан; 3-метилбут-1-ен;  

2-хлоропентанова кислота 

2, 9, 14 

Бутан; 2,2-диметил-3-хлоро-пентан; 4,5-

диметилгекс-2-ен;  

3-метил-2-йодобутанова кислота 

3, 8, 13 

Пентан; 3-етил-2-метилгептан; 3,4-диметилпент-

2-ин;  

2,2-диметилгекс-2-ол 

4, 7, 12 

Гексан; 3,5-диетил-3-метилгексан; 3,3-диметил-

бут-1-ин;  

2,2-дибромопропанова кислота 

5, 6, 11 
Гептан; 1-бром-2,3-диметилбутан; 2-бромо-3,4-

диметилгекс-3-ен; бутан-1,2-діол 

 

2. Назвіть побудовані сполуки за допомогою кнопки "Convert 

Strukture to Name" у меню Strukture. 



39 

3. Створіть новий документ Word з назвою – номер 

варіанта_прізвище ім’я (1_Чайка Микола). Зробіть копію 

створених у ChemDraw структурних формул та їх назв відповідно 

до систематичної номенклатури, вставте їх на першу сторінку 

документу. 

 

b) Зображення формул циклічних хімічних сполук. 

1.  Намалюйте структурні формули циклічних органічних 

речовин використовуючи наявні інструменти з меню «Tools» 

відповідно до варіанту: 

Парні варіанти Непарні варіанти 

1. Намалюйте хімічну 

формулу бензину → 

трансформуйте її в толуен 

→ п-крезол. 

2. Намалюйте хімічну 

формулу нафталену → 

трансформуйте його в -

нафтол. 

3. Намалюйте хімічну 

формулу циклооктану, 

трансформуйте його в 1,3-

диметил-2-хлороциклооктан. 

1. Намалюйте хімічну 

формулу бензину → 

трансформуйте її в анілін → п-

фенілендіамін. 

2. Намалюйте хімічну 

формулу нафталену → 

трансформуйте його в α-

нафтол. 

3. Намалюйте хімічну 

формулу циклогексану, 

трансформуйте його в 1-етил-2-

бромоциклогексан. 

 

2. Назвіть побудовані сполуки за допомогою кнопки "Convert 

Strukture to Name" у меню Strukture. 

3. Скопіюйте всі представлені структурні формули та вставте 

їх на 2 сторінку створеного документу. 

 

c) Створення структурних формул за назвою. 

 

1. Генерація за назвою ІЮПАК.  

➢ Парні варіанти: наберіть текст octane (октан), виділіть 

його та згенеруйте структуру цієї сполуки, активуючи 

функцію "Convert Name to Strukture". 
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➢ Непарні варіанти: наберіть текст heptane (гептан), 

виділіть його та згенеруйте структуру цієї сполуки, 

активуючи функцію "Convert Name to Strukture". 

2. Перетворіть побудовану автоматично формулу в 

напівструктурну. 

3. При активній кнопці "Check Structure" перевірте виділену 

молекулярну структуру на наявність помилок. 

4. Зробіть зміни у довжинах зв’язків у побудованій структурі. 

Виділіть сполуку. Кнопкою "Clean Up Structure" перевірте 

структуру на відповідність параметрів молекули звичайним 

довжинам зв'язків і валентних кутів з автоматичним їх 

виправленням. 

5. Cкопіюйте структурну формулу та вставте її на 3 сторінку 

створеного документу. 

 

d) Створення структурних формул речовин за допомогою 

SMILES 

 

SMILES (англ. Simplified Molecular Input Line Entry 

Specification) – специфікація спрощеного представлення молекул 

в рядку введення – система правил (специфікація) однозначного 

опису складу та структури молекули хімічної речовини з 

використанням рядка символів ASCII у рядковому типі. 

1. Зобразіть за допомогою функції SMILES формули сполук 

згідно варіантів: 

 

Варіант Речовина 

1, 10, 15 Аденін, рибоза 

2, 9, 14 Гуанін, арабіноза 

3, 8, 13 Цитозин, фруктоза 

4, 7, 12 Урацил, галактоза 

5, 6, 11 Тимін; глюкоза 

2. Використовуючи мережу інтернет і відкриті бази хімічних 

даних або довідники знайдіть рядок символів, складений за 

правилами SMILES для вашої органічної речовини та вставте цей 

код у ChemDraw через: Edit → Paste Spesial → SMILES. 
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3. Дайте назви побудованим сполукам згідно систематичної 

номенклатури за допомогою кнопки "Convert Strukture to Name" у 

меню Strukture. 

4. Скопіюйте всі представлені структурні формули, їх назви а 

також коди SMILES та вставте їх на 4 сторінку створеного 

документу Word. 

 

e) Вивчення властивостей сполук. 

 

1. Зобразіть за допомогою шаблонів (Templates) структурну 

формулу амінокислоти згідно варіантів: 

Варіант Амінокислота 

1, 10, 15 Серин (Ser) 

2, 9, 14 Триптофан (Trp) 

3, 8, 13 Гістидин (His) 

4, 7, 12 Лізин (Lys) 

5, 6, 11 Тирозин (Tyr) 

 

2. Проаналізуйте її будову: View → Show Analysis Window 

або виділити формулу → права кнопка →Analysis. 

3. Розгляньте властивості цієї речовини: View → Show 

Chemical Properties Window. 

4. Натисніть кнопку Report та збережіть інформацію про цю 

речовину у тестовому редакторі «Блокнот». 

Cкопіюйте структурну формулу амінокислоти, інформацію 

про цю речовину та вставте їх на останню сторінку створеного 

документу Word. 

 

Відправте файли виконаної лабораторної роботи на е-пошту 

викладача, у темі листа обов’язково вказіть прізвище та номер 

лабораторної роботи. 

 

4. Презентація підготовлених повідомлень здобувачами 

вищої освіти 
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За бажанням оберіть запропоновану тему повідомлення з 

теми, яку вивчаєте. Підготуйте усний виступ та електронну 

презентацію з теми. Будьте готові виступити перед аудиторією. 

Теми повідомлень: 

Застосування SMILES у хімічному моделюванні. 

Редактори хімічних структур: ChemDraw vs MarvinSketch. 

Автоматичне генерування назв сполук та їх верифікація. 

Основні помилки під час побудови формул у хімічних 

редакторах. 

Використання шаблонів органічних молекул у програмному 

забезпеченні. 

Рекомендована література 

Основна: 

1. Bienz S. Short Manual to the Chemical Drawing Program 

ChemDraw / S. Bienz. University of Zurich. 2013. – 22 p. 

2. Олексеюк С.Т., Проц Д.І., Супрунович С.В. Прикладні 

комп’ютерні програми для аналітичної та органічної хімії. – 

Луцьк: РВВ „Вежа” ВДУ ім. Лесі Українки, 2004, – Ч.І. – 82 с. 

3. Бондар О.С. Практикум з комп’ютерної хімії. Навчальний 

посібник. Чернігів: ЧНПУ, 2017. – 68 с. 

4. Туровський М.А., Туровська О. М. Практичний курс 

комп’ютерної структурної хімії. Навчальний посібник. Донецьк: 

ДонНУ, 2004. 131 с. 

5. Білий О.В., Біла Н.І. Створення та редагування хімічної 

графіки в програмі ChemDraw. Учбово-методичний посібник. 

Донецьк: ДонНУ, 2003. 45 с. 

Додаткова: 

1. Jensen F. Introduction to Computational Chemistry. – London, 

1999. – 429. 

2. Коновалова С.О. Комп’ютерні та інформаційні технології в 

хімії: стислий конспект лекцій. – Краматорськ: ДДМА, 2020. – 80 

с. 

3. Кулігін М.Л. Комп’ютерна хімія: конспект лекцій. – Херсон: 

ХНТУ, 2013. – 80 с. 

 

Дата                                                      Підпис викладача  
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Лабораторна робота №6 

Тема: Складання та запис рівнянь хімічних реакцій за 

допомогою спеціального редактора хімічних формул ChemDraw. 

Мета: Навчитися зображати рівняння хімічних реакцій 

(неорганічних та органічних), створювати механізми реакцій із 

застосуванням стрілок, позначати реакційні центри та 

опрацьовувати структурні формули з дотриманням хімічної 

номенклатури.  

Основні поняття: структурна формула, йонне рівняння, 

механізм реакції, стрілки реакцій, хімічна символіка, приєднання, 

заміщення, Templates. 

План заняття: 

1. Організаційний момент. 

2. Тестовий контроль знань здобувачів вищої освіти. 

3. Теоретичне опитування за планом самостійної роботи. 

4. Виконання лабораторної роботи. 

5. Презентація підготовлених повідомлень здобувачами вищої 

освіти. 

Інструкція до виконання: 

1. Тестовий контроль знань 

Опрацюйте запропоновані літературні джерела та 

підготуйтесь до індивідуального тестування за основними 

поняттями теми. 

2. Теоретичне опитування за планом самостійної роботи 

Самостійно опрацюйте запропоновані контрольні 

запитання/завдання та підготуйтеся до усного виступу та 

співбесіди за ними. 

Контрольні запитання/завдання  

1. Як створити та відформатувати йонне рівняння в 

ChemDraw? 

2. У чому полягає різниця між реакцією заміщення та 

реакцією приєднання? 

3. Як вставити стрілки в реакційну схему? 

4. Як використовується вкладка Templates для побудови 

біомолекул? 
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3. Виконання лабораторної  роботи 

Завдання до лабораторної роботи: 

a) Зображення структурних формул неорганічних сполук та 

йонних рівнянь реакцій. 

1. Зобразіть структурні формули неорганічних речовин 

використовуючи наявні інструменти з меню «Tools» відповідно 

до варіанту: 

Парні варіанти Непарні варіанти 

N2O5 

Al2(SO4)3 

NaNO3 

Fe2O3 

Li2SO4 

Ca(HCO3)2 

 

2. При активній кнопці "Check Structure" перевірте 

побудовані структури на наявність помилок. 

3. Запишіть скорочене йонне рівняння утворення 

неорганічних речовин згідно варіантів використовуючи наявні 

інструменти з меню «Tools», зокрема «Chemical Symbols». 

Оберіть шрифт Georgia, розмір – 14. Застосуйте режим 

відображення з сіткою через View – Show Crosshair.  

 

Парні варіанти Непарні варіанти 

1. NaOH 

2. BaSO4 

4. NH4OH 

5. CaCl2 

 

4. Створіть новий документ Word з назвою – номер 

варіанта_прізвище ім’я (1_Чайка Микола). Зробіть копію 

створених у ChemDraw йонних рівнянь та вставте їх на першу 

сторінку документу. 

5. Збережіть документ ChemDraw (File – Save As) у власній 

папці на диску Д із вказанням номеру лабораторної роботи, 

варіанту, завдання і вашого прізвища та імені (4.1.1_Чайка 

Микола) 

b) Створення та редагування рівнянь органічних реакцій. 

1.  Зобразіть рівнянь реакції заміщення використовуючи 

наявні інструменти з меню «Tools», зокрема «Arrows» та 

«Chemical Symbols»  відповідно до варіанту та покажіть 
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фігурними стрілками, які атоми та в якому положенні 

заміщуються. Увага! Формули реагуючих речовин та продуктів 

реакції повинні бути структурними! 

 

Парні варіанти Непарні варіанти 

1. СH4 + Cl2 

2. C6H6 + HNO3 

1. CH3Cl + NaOH 

2. C6H5NH2 (анілін) + Br2 

 

2. Дайте назви побудованим сполукам згідно систематичної 

номенклатури за допомогою кнопки "Convert Strukture to Name" 

у меню Strukture. 

3. Зобразіть рівнянь реакції приєднання використовуючи 

наявні інструменти з меню «Tools» відповідно до варіанту та 

покажіть фігурними стрілками, які атоми та в яке положення 

приєднуються. Виділіть ці атоми (групи атомів) синім кольором. 

Увага! Формули реагуючих речовин та продуктів реакції повинні 

бути структурними! 

Варіант Речовина 

1, 10, 15 
Пент-1-ен + Br2 

Бутен + H2О 

2, 9, 14 
Ацетилен + HCl 

3-метилпент-1-ин + Н2 

3, 8, 13 
3-метилбут-1-ен + Н2 

Етен + Br2 

4, 7, 12 
Пропін + Cl2 

Ацетилен + H2О 

5, 6, 11 
Пропен + H2О 

Ацетилен + 2HCl 

6. Створіть новий документ Word з назвою – номер 

варіанта_прізвище ім’я (1_Чайка Микола). Зробіть копію 

створених у ChemDraw рівнянь та вставте їх на першу сторінку 

документу. 

7. Збережіть документ ChemDraw (File – Save As) у власній 

папці на диску Д із вказанням номеру лабораторної роботи, 

варіанту, завдання і вашого прізвища та імені (4.1.1_Чайка 

Микола). 



46 

 

c) Створення та редагування рівнянь органічних реакцій за 

участю оксигеновмісних речовин. 

 

1. Зобразіть рівнянь органічних реакцій за участю 

оксигеновмісних речовин відповідно до варіанту та покажіть 

фігурними стрілками, які атоми та в якому положенні 

заміщуються/приєднуються, виділіть утворені зв’язки окремим 

кольором. Увага! Формули реагуючих речовин та продуктів 

реакції повинні бути структурними! 

 

Парні варіанти Непарні варіанти 

1. Етиленгліколь + Сu(OH)2 

2. Фенол + FeCl3 

3. Оцтова кислота + етанол 

1. Гліцерин + Сu(OH)2 

2. Формальдегід + фенол 

3. Пропанова кислота + метанол 

 

2. Використовуючи шаблони «Hexoses» із вкладки Templates  

оберіть серед представлених структурну формулу глюкози та 

запишіть рівняння реакції спиртового (для парних варіантів) або 

молочнокислого бродіння (для непарних варіантів). Назвіть 

утворені сполуки через вкладку «Strukture». 

4. Створіть новий документ Word з назвою – номер 

варіанта_прізвище ім’я (1_Чайка Микола). Зробіть копію 

створених у ChemDraw рівнянь та вставте їх на першу сторінку 

документу. 

5. Збережіть документ ChemDraw (File – Save As) у власній 

папці на диску Д із вказанням номеру лабораторної роботи, 

варіанту, завдання і вашого прізвища та імені (4.1.1_Чайка 

Микола). 

 

Увага у листі повинно бути прикріплено 3 документи Word  

та 3 файла ChemDraw, в яких Ви виконували кожну вправу. 

Відправте файли виконаної лабораторної роботи на е-пошту 

викладача, у темі листа обов’язково вказіть прізвище та номер 

лабораторної роботи. 
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4. Презентація підготовлених повідомлень здобувачами 

вищої освіти 

За бажанням оберіть запропоновану тему повідомлення з 

теми, яку вивчаєте. Підготуйте усний виступ та електронну 

презентацію з теми. Будьте готові виступити перед аудиторією. 

Теми повідомлень: 

Візуалізація органічних реакцій: основні підходи. 

Запис іонних реакцій у хімічних редакторах. 

Особливості відображення електронного ефекту у структурі. 

Приклади реакцій заміщення та приєднання в органічній хімії. 

Шаблони біомолекул і їх використання в ChemDraw. 

Рекомендована література 

Основна: 

1. Bienz S. Short Manual to the Chemical Drawing Program 

ChemDraw / S. Bienz. University of Zurich. 2013. – 22 p. 

2. Олексеюк С.Т., Проц Д.І., Супрунович С.В. Прикладні 

комп’ютерні програми для аналітичної та органічної хімії. – 

Луцьк: РВВ „Вежа” ВДУ ім. Лесі Українки, 2004, – Ч.І. – 82 с. 

3. Бондар О.С. Практикум з комп’ютерної хімії. Навчальний 

посібник. Чернігів: ЧНПУ, 2017. – 68 с. 

4. Туровський М.А., Туровська О. М. Практичний курс 

комп’ютерної структурної хімії. Навчальний посібник. Донецьк: 

ДонНУ, 2004. 131 с. 

5. Білий О.В., Біла Н.І. Створення та редагування хімічної 

графіки в програмі ChemDraw. Учбово-методичний посібник. 

Донецьк: ДонНУ, 2003. 45 с 

Додаткова: 

1. Jensen F. Introduction to Computational Chemistry. – London, 

1999. – 429. 

2. Коновалова С.О. Комп’ютерні та інформаційні технології в 

хімії: стислий конспект лекцій. – Краматорськ: ДДМА, 2020. – 80 

с. 

3. Кулігін М.Л. Комп’ютерна хімія: конспект лекцій. – Херсон: 

ХНТУ, 2013. – 80 с. 

 

Дата                                                      Підпис викладача  
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Лабораторна робота №7 

Тема: Створення трьохмірних моделей молекул за 

допомогою редактора Chem3D. 

Мета: Навчитися використовувати програму Chem3D для 

побудови 3D-моделей молекул, оптимізації геометрії, перегляду 

валентних кутів і довжин зв’язків, збереження моделей для 

подальшої презентації або розрахунків.  

Основні поняття: трьохмірна модель, валентні кути, 

оптимізація геометрії, Ball & Stick, 3D-молекула, енергетичний 

мінімум, імпорт/експорт структур. 

План заняття: 

1. Організаційний момент. 

2. Тестовий контроль знань здобувачів вищої освіти. 

3. Теоретичне опитування за планом самостійної роботи. 

4. Виконання лабораторної роботи. 

5. Презентація підготовлених повідомлень здобувачами вищої 

освіти. 

Інструкція до виконання: 

1. Тестовий контроль знань 

Опрацюйте запропоновані літературні джерела та 

підготуйтесь до індивідуального тестування за основними 

поняттями теми. 

2. Теоретичне опитування за планом самостійної роботи 

Самостійно опрацюйте запропоновані контрольні 

запитання/завдання та підготуйтеся до усного виступу та 

співбесіди за ними. 

Контрольні запитання/завдання  

1. Які формати структур підтримує Chem3D? 

2. Як оптимізувати структуру молекули в Chem3D? 

3. Які основні стилі відображення молекул доступні у 

Chem3D? 

4. Як виміряти довжину зв’язку та кут у моделі? 

5. Які переваги має тривимірне моделювання в хімії?? 

 

3. Виконання лабораторної  роботи 
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Завдання до лабораторної роботи: 

a) Зображення 3D-моделей молекул простих неорганічних 

речовин. 

Створіть новий файл «File – New» та назвіть його із 

вказанням номеру лабораторної роботи, завдання і вашого 

прізвища та імені (7.1_Чайка Микола).  

За допомогою інструменту «Текст» у правій частині 

програми у відповідному робочому полі створіть формули 

молекул (наприклад кисень, водень, хлор). Для цього поступово 

приєднуйте атоми до молекули за допомогою відповідних 

зв'язків. Зверніть увагу, що кожен атом в 3D-моделі позначається 

певним кольором, наприклад Карбон - сірий, Гідроген - голубий, 

Оксиген - червоний.  

Щоб змінити масштаб створених моделей використовуйте 

колесо «миші». Для перегляду окремих зв’язків, властивостей 

створених моделей молекул простих та складних речовин у 

Chem3D є інструменти, що вмикають автоматичне обертання 

об’єктів. Ці додаткові інструменти знаходяться на додатковій 

верхній панелі «Analyze» або натистувши праву кнопку – «model 

demo».  

Перегляньте створені моделі, обертаючи їх в різні сторони. 

Після натискання вкладки анімації над робочою областю 

з’являється панель керування, що дозволяє запускати, зупиняти 

та продовжувати обертання моделі, а також для змінювати 

напрям її руху. 

 
Переглядаючи складні моделі для зручності можна 

ввімкнути показ символів хімічних елементів за допомогою 

команди: права кнопка - Show Atom Symbols. 

Створіть в Chem3D трьохвимірні моделі молекул 

метану, етену, нітратної та сульфатної кислоти, гідроген 

перекису та вуглекислого газу. 

Для створених моделей покажіть назви атомів, їх номери. 

Для цього увімкніть відповідні кнопки з панелі інструментів або 

через праву кнопку миші – Atom Symbol (Atom Number). 



50 

Для моделей молекул кислот перегляньте по черзі всі типи 

зображення молекули з «Model Display Mode» пункту меню 

«View», проаналізуйте коли краще використовувати окремий тип.  

Збережіть документ Chem3D (File – Save As) у власній 

папці . 

 

b) Створення трьохвимірних моделей ланцюгів полімерів. 

Створіть в Chem3D наступні 3D-моделі фрагменту 

ланцюга молекул полімерів: 

 

Парні варіанти Непарні варіанти 

Поліетилен 

Поліізобутилен 

Поліпропілен 

Полібутилен 

 

Збережіть документ Chem3D (File – Save As) у власній 

папці із вказанням номеру лабораторної роботи, варіанту, 

завдання і вашого прізвища та імені (5.1.2_Чайка Микола). 

 

c) Створення та редагування 3D-моделей рівнянь 

неорганічних реакцій. 

 

Створіть у Chem3D наступні моделі простих рівнянь реакцій:  

Під час створення дотримуйтесь напряму перетворень –  

розпочніть з запису реагентів та рухайтесь праворуч. Зверніть 

увагу: знаки «+» і «=» в трьохвимірних моделях Chem3D не 

відображаються.  

Ви можете створити рівняння реакцій у програмі 

ChemDraw, скопіювати та вставити у Chem3D.  

Кожну реакцію збережіть в окремий файл File – Save As у 

форматі (jpeg., png) з відповідною назвою, наприклад «Завдання 

3_Реакція_1_парний варіант) 

Парні варіанти Непарні варіанти 

1. 2HNO3+Na2O=2NaNO3+H2O 

2. NaCl+H2SO4=NaHSO4+HCl 

1.CaCO3+2HCl=CaCl2+H2O+CO2 

2. Ba(OH)2+SO3=BaSO4+H2O 
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d) Створення та редагування 3D-моделей молекул та 

рівнянь органічних реакцій. 

Оскільки, як Ви вже переконалися створення складних 3D-

моделей у Chem3D потребує значного часу та зусиль, то для 

створенням складних моделей молекул краще записувати 

структурні формули речовин у ChemDraw, далі виділяти її та 

копіювати у буфер обміну. Після цього запустити Chem3D у 

пункті меню «Edit» обрати підпункт «Paste». Chem3D самостійно 

сконвертує вставлену двохвимірну структурну формулу в 

тривимірну.  

Якщо Ви відкриєте у програмі Chem3D файл з програми 

ChemDraw, то як наслідок, відбудеться автоматичне 

конвертування 2D-структури в тривимірну модель. Якщо у файлі 

збережено декілька формул, то вони всі сконвертуються та будуть 

розташовані у вікні Chem3D. 

 

Запустіть Chem3D та відкрийте файл ChemDraw, який Ви 

створили, виконуючи Лабораторну роботу 4: завдання 2.3 – 

рівняння реакцій приєднання та завдання 3.1 - реакції за участю 

оксигеновмісних речовин. Експортуйте всі записані Вами 

сполуки та рівняння в трьохмірні моделі. Кожне завдання 

збережіть в окремий файл з відповідними назвами «Завдання 

4_реакції приєднання_ПІБ студента», «Завдання 4_реакції 

оксигеновмісних речовин_ПІБ студента». 

 

Відправте файли виконаної лабораторної роботи на е-пошту 

викладача, у темі листа обов’язково вказіть прізвище та номер 

лабораторної роботи. 

 

Увага у повідомленні повинно бути 2 зображення рівнянь 

неорганічних реакцій (завдання 3)  та 4 файла Chem3D, в яких 

Ви виконували завдання 1, 2 та два файла із вправи 4. 

 

За відсутності пакету програм СhemOffice лабораторну 

роботу можна виконувати на онлайн ресурсі за адресою: 

https://molview.org/ 

https://molview.org/
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4. Презентація підготовлених повідомлень здобувачами 

вищої освіти 

За бажанням оберіть запропоновану тему повідомлення з 

теми, яку вивчаєте. Підготуйте усний виступ та електронну 

презентацію з теми. Будьте готові виступити перед аудиторією. 

Теми повідомлень: 

Створення та редагування 3D-моделей у Chem3D. 

Візуалізація будови біомолекул у 3D. 

Порівняння Ball & Stick, Space-Filling та інших режимів 

візуалізації. 

Застосування Chem3D у підготовці графічних матеріалів до 

публікацій. 

Рекомендована література 

Основна: 

1. Bienz S. Short Manual to the Chemical Drawing Program 

ChemDraw / S. Bienz. University of Zurich. 2013. – 22 p. 

2. Олексеюк С.Т., Проц Д.І., Супрунович С.В. Прикладні 

комп’ютерні програми для аналітичної та органічної хімії. – 

Луцьк: РВВ „Вежа” ВДУ ім. Лесі Українки, 2004, – Ч.І. – 82 с. 

3. Бондар О.С. Практикум з комп’ютерної хімії. Навчальний 

посібник. Чернігів: ЧНПУ, 2017. – 68 с. 

4. Туровський М.А., Туровська О. М. Практичний курс 

комп’ютерної структурної хімії. Навчальний посібник. Донецьк: 

ДонНУ, 2004. 131 с. 

5. Білий О.В., Біла Н.І. Створення та редагування хімічної 

графіки в програмі ChemDraw. Учбово-методичний посібник. 

Донецьк: ДонНУ, 2003. 45 с 

Додаткова: 

1. Коновалова С.О. Комп’ютерні та інформаційні технології в 

хімії: стислий конспект лекцій. – Краматорськ: ДДМА, 2020. – 80 

с. 

2. Кулігін М.Л. Комп’ютерна хімія: конспект лекцій. – Херсон: 

ХНТУ, 2013. – 80 с. 

 

 

Дата                                                      Підпис викладача  



53 

Лабораторна робота №8 

Тема: Побудова та оптимізація геометрії органічної 

молекули в програмі HyperChem. 

Мета: Ознайомитися з основами роботи в програмі 

HyperChem. Навчитися будувати 3D-моделі молекул, виконувати 

попередню геометричну оптимізацію та розраховувати основні 

фізико-хімічні параметри простої органічної молекули.  

Основні поняття: HyperChem, молекулярна геометрія, 

оптимізація геометрії, MM+, Semi-Empirical (AM1, PM3), Partial 

Charge. 

План заняття: 

1. Організаційний момент. 

2. Тестовий контроль знань здобувачів вищої освіти. 

3. Теоретичне опитування за планом самостійної роботи. 

4. Виконання лабораторної роботи. 

5. Презентація підготовлених повідомлень здобувачами вищої 

освіти. 

Інструкція до виконання: 

1. Тестовий контроль знань 

Опрацюйте запропоновані літературні джерела та 

підготуйтесь до індивідуального тестування за основними 

поняттями теми. 

2. Теоретичне опитування за планом самостійної роботи 

Самостійно опрацюйте запропоновані контрольні 

запитання/завдання та підготуйтеся до усного виступу та 

співбесіди за ними. 

Контрольні запитання/завдання  

1. Що таке оптимізація геометрії в HyperChem? 

2. У чому відмінність між методами MM+ і PM3? 

3. Що таке частковий заряд і як він розраховується? 

4. Які формати використовуються для збереження моделей?? 

 

3. Виконання лабораторної  роботи 

 

1. Запуск програми та ознайомлення з інтерфейсом 

1. Відкрийте HyperChem. 
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2. Ознайомтеся з елементами вікна: 

✓ Робоча область (молекулярне поле), 

✓ Панель побудови, 

✓ Панель управління моделлю, 

✓ Меню: File, Build, Setup, Compute, Display, Window. 

 

2. Побудова молекули метанолу (CH₃OH) 

1. У меню Build → Draw, виберіть атом C. 

2. Клацніть на робочому полі — з’явиться атом вуглецю. 

3. Додайте водні атоми (інструмент H) — клацніть 3 рази 

навколо атома С. 

4. Додайте ОН-групу: 

✓ Виберіть атом O, приєднайте до С. 

✓ До О додайте один H. 

Перевірка: молекула має вигляд CH₃–OH. 

5. У меню Build → Add Hydrogens — перевірка 

автоматичного добудування воднів. 

6. Збережіть структуру (File → Save As → Methanol.hin). 

 

3. Оптимізація геометрії 

1. У меню Setup → Molecular Mechanics…: 

✓ Виберіть метод MM+. 

✓ Натисніть OK. 

2. У меню Compute → Geometry Optimization: 

✓ Відзначте галочку OK — запуститься оптимізація. 

✓ Дочекайтесь завершення (індикатор у нижній 

частині вікна). 

 

4. Обчислення часткових зарядів 

1. Setup → Semi-Empirical → оберіть метод PM3. 

2. У меню Compute → Charges → Mulliken. 

3. Часткові заряди з’являться біля кожного атома. 

 

5. Збереження результатів 

1. File → Save As → Methanol_final.hin 

2. File → Export → Picture (зберегти зображення для звіту). 
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Завдання до лабораторної роботи: 

1. Побудуйте та оптимізуйте молекулу етану (CH₃–CH₃). 

2. Обчисліть часткові заряди на атомах. 

3. Порівняйте довжину зв’язків у етанолі та метанолі. 

 
Звітність: 

✓ Побудована модель (скріншот). 

✓ Метод оптимізації. 

✓ Значення часткових зарядів. 

✓ Коментар до отриманої форми молекули. 

 

Відправте файли виконаної лабораторної роботи на е-пошту 

викладача, у темі листа обов’язково вказіть прізвище та номер 

лабораторної роботи. 

 

4. Презентація підготовлених повідомлень здобувачами 

вищої освіти 

За бажанням оберіть запропоновану тему повідомлення з 

теми, яку вивчаєте. Підготуйте усний виступ та електронну 

презентацію з теми. Будьте готові виступити перед аудиторією. 

Теми повідомлень: 

HyperChem: загальні можливості та застосування в комп’ютерній 

хімії. 

Порівняння методів геометричної оптимізації: молекулярна 

механіка MM+ та напівемпіричні методи AM1, PM3. 

Візуалізація молекул у HyperChem: тривимірні моделі, типи 

відображення, маніпуляції. 

Розрахунок електростатичного потенціалу молекул: 

інтерпретація та практичне значення. 

Нормальні коливання молекул та віртуальний ІЧ-спектр у 

HyperChem.. 

Рекомендована література 

Основна: 

1. Bienz S. Short Manual to the Chemical Drawing Program 

ChemDraw / S. Bienz. University of Zurich. 2013. – 22 p. 
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2. Олексеюк С.Т., Проц Д.І., Супрунович С.В. Прикладні 

комп’ютерні програми для аналітичної та органічної хімії. – 

Луцьк: РВВ „Вежа” ВДУ ім. Лесі Українки, 2004, – Ч.І. – 82 с. 

3. Бондар О.С. Практикум з комп’ютерної хімії. Навчальний 

посібник. Чернігів: ЧНПУ, 2017. – 68 с. 

4. Туровський М.А., Туровська О. М. Практичний курс 

комп’ютерної структурної хімії. Навчальний посібник. Донецьк: 

ДонНУ, 2004. 131 с. 

Додаткова: 

1. Туровська О. М. Практикум з квантової хімії. Навчально-

методичний посібник / О. М. Туровська, М.А. Туровський. 

Донецьк: ДонНУ, 2007. – 81 с. 

2. Коновалова С.О. Комп’ютерні та інформаційні технології в 

хімії: стислий конспект лекцій. – Краматорськ: ДДМА, 2020. – 80 

с. 

3. Кулігін М.Л. Комп’ютерна хімія: конспект лекцій. – Херсон: 

ХНТУ, 2013. – 80 с. 

 

 

 

 

Дата                                                      Підпис викладача 
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Лабораторна робота №9 

Тема: Проведення квантово-хімічного розрахунку та аналіз 

електростатичного потенціалу молекули в HyperChem. 

Мета: Навчитися використовувати розширені можливості 

програми HyperChem: проводити квантово-хімічні розрахунки, 

аналізувати електростатичний потенціал та створювати графічні 

зображення молекул з відображенням зарядів і енергетичних 

характеристик. 

Основні поняття: HyperChem, електростатичний потенціал 

Surface Map, Orbital map. 

План заняття: 

1. Організаційний момент. 

2. Тестовий контроль знань здобувачів вищої освіти. 

3. Теоретичне опитування за планом самостійної роботи. 

4. Виконання лабораторної роботи. 

5. Презентація підготовлених повідомлень здобувачами вищої 

освіти. 

Інструкція до виконання: 

1. Тестовий контроль знань 

Опрацюйте запропоновані літературні джерела та 

підготуйтесь до індивідуального тестування за основними 

поняттями теми. 

2. Теоретичне опитування за планом самостійної роботи 

Самостійно опрацюйте запропоновані контрольні 

запитання/завдання та підготуйтеся до усного виступу та 

співбесіди за ними. 

Контрольні запитання/завдання  

1. Що таке електростатичний потенціал та як він 

візуалізується в HyperChem? 

2. Яке значення мають орбіталі HOMO і LUMO? 

3. Як проводиться енергетичний розрахунок у PM3? 

4. Чому важливо враховувати ESP при аналізі реакційної 

здатності?? 

 

3. Виконання лабораторної  роботи 
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1. Побудова молекули ацетону (CH₃–CO–CH₃) 

• В меню Build → Draw побудуйте: 

✓ центральний атом C=O (двозв’язок), 

✓ два метильних фрагменти з обох боків. 

• Add Hydrogens → добудова воднів. 

• Збережіть файл як Acetone.hin. 

 

2. Геометрична оптимізація 

• Setup → Semi-Empirical → PM3 

• Compute → Geometry Optimization → OK 

• Дочекайтесь завершення. 

 

3. Побудова поверхні електростатичного потенціалу 

1. Setup → Compute → Orbitals 

✓ Встановіть метод PM3, натисніть OK. 

✓ Оберіть Single Point Energy Calculation → 

Compute. 

✓ Дочекайтесь розрахунку. 

2. Display → Orbitals → Electrostatic Potential Map 

✓ Відзначте галочку «On Molecule» 

✓ Натисніть OK — з’явиться кольорова карта 

потенціалу. 

    червоний — негативний потенціал,     синій — позитивний. 

 

4. Побудова енергетичної діаграми (орбіталі) 

• Display → Orbitals → Surfaces 

• Оберіть HOMO / LUMO 

• Увімкніть відображення positive / negative phase 

• Візуалізуйте фронтирні орбіталі. 

 

 5. Збереження результатів: 

• File → Export → Picture (для вставки у звіт). 

• Збережіть .hin і .bmp файли. 

 

Завдання для студентів: 

1. Проведіть аналогічний розрахунок для ацетальдегіду. 
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2. Порівняйте розподіл електростатичного потенціалу з 

ацетоном. 

3. Побудуйте енергетичну діаграму HOMO–LUMO для 

обох молекул. 

 

Відправте файли виконаної лабораторної роботи на е-пошту 

викладача, у темі листа обов’язково вказіть прізвище та номер 

лабораторної роботи. 

 

4. Презентація підготовлених повідомлень здобувачами 

вищої освіти 

За бажанням оберіть запропоновану тему повідомлення з 

теми, яку вивчаєте. Підготуйте усний виступ та електронну 

презентацію з теми. Будьте готові виступити перед аудиторією. 

Теми повідомлень: 

Моделювання водневих зв’язків та міжмолекулярних взаємодій у 

HyperChem. 

Фронтирні орбіталі (HOMO / LUMO): принципи, візуалізація, 

значення. 

Розрахунок часткових атомних зарядів у HyperChem: методи та 

приклади. 

Прогноз хімічної реакційної здатності речовин за допомогою 

електронної будови. 

Побудова потенціальної енергетичної поверхні (PES) у 

HyperChem: обертання, бар’єри, конформації. 

Дипольний момент молекули: розрахунок у HyperChem і хімічне 

значення. 

Застосування HyperChem у дослідженнях біоактивних сполук та 

фармацевтичному аналізі. 

 

Рекомендована література 

Основна: 

1. Bienz S. Short Manual to the Chemical Drawing Program 

ChemDraw / S. Bienz. University of Zurich. 2013. – 22 p. 
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2. Олексеюк С.Т., Проц Д.І., Супрунович С.В. Прикладні 

комп’ютерні програми для аналітичної та органічної хімії. – 

Луцьк: РВВ „Вежа” ВДУ ім. Лесі Українки, 2004, – Ч.І. – 82 с. 

3. Бондар О.С. Практикум з комп’ютерної хімії. Навчальний 

посібник. Чернігів: ЧНПУ, 2017. – 68 с. 

4. Туровський М.А., Туровська О. М. Практичний курс 

комп’ютерної структурної хімії. Навчальний посібник. Донецьк: 

ДонНУ, 2004. 131 с. 

Додаткова: 

1. Туровська О. М. Практикум з квантової хімії. Навчально-

методичний посібник / О. М. Туровська, М.А. Туровський. 

Донецьк: ДонНУ, 2007. – 81 с. 

2. Коновалова С.О. Комп’ютерні та інформаційні технології в 

хімії: стислий конспект лекцій. – Краматорськ: ДДМА, 2020. – 80 

с. 

3. Кулігін М.Л. Комп’ютерна хімія: конспект лекцій. – Херсон: 

ХНТУ, 2013. – 80 с. 

 

 

 

 

 

Дата                                                      Підпис викладача 
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Лабораторна робота №10 

Тема: Розрахунок інфрачервоного (ІЧ) спектру молекули за 

допомогою програми HyperChem. 

Мета: Навчитися будувати модель молекули в середовищі 

HyperChem, виконувати геометричну оптимізацію та проводити 

квантово-хімічний розрахунок вібраційних частот, на основі яких 

формуються ІЧ-спектри. Ознайомитися з базовими принципами 

віртуального ІЧ-аналізу. 

Основні поняття: ІЧ-спектр, коливальні частоти, 

геометрична оптимізація, вібраційний аналіз, нормальні 

коливання. 

План заняття: 

1. Організаційний момент. 

2. Тестовий контроль знань здобувачів вищої освіти. 

3. Теоретичне опитування за планом самостійної роботи. 

4. Виконання лабораторної роботи. 

5. Презентація підготовлених повідомлень здобувачами вищої 

освіти. 

Інструкція до виконання: 

1. Тестовий контроль знань 

Опрацюйте запропоновані літературні джерела та 

підготуйтесь до індивідуального тестування за основними 

поняттями теми. 

2. Теоретичне опитування за планом самостійної роботи 

Самостійно опрацюйте запропоновані контрольні 

запитання/завдання та підготуйтеся до усного виступу та 

співбесіди за ними. 

Контрольні запитання/завдання  

1. Що означає піки в ІЧ-спектрі молекули? 

2. Які коливання належать до валентних, а які — до 

деформаційних? 

3. Яка частота характерна для коливань зв’язку C=O? 

4. Чому необхідна оптимізація геометрії перед вібраційним 

аналізом? 

5. Як у HyperChem візуалізуються нормальні коливання? 
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3. Виконання лабораторної  роботи 

 

1. Побудова молекули 

Розглянемо молекулу ацетону CH₃–CO–CH₃ 

1. File → New 

2. Build → Draw 

3. Виберіть атом C, побудуйте: 

✓ центральний С з двозв’язком до O; 

✓ зліва і справа — CH₃-групи. 

4. Build → Add Hydrogens — автоматичне доповнення 

воднів. 

5. Build → Clean Geometry — первинне вирівнювання 

молекули. 

 

2. Геометрична оптимізація 

1. Setup → Semi-Empirical → PM3 

(або AM1 — на вибір; PM3 швидший, AM1 точніший). 

2. Compute → Geometry Optimization → OK 

Дочекайтесь завершення (моніторинг — у статусній 

стрічці). 

 

3. Розрахунок ІЧ-спектру (віртуального) 

1. Setup → Vibrations… 

✓ Метод: PM3 або AM1 (той самий, що й для 

оптимізації) 

✓ Перевірте: «Calculate IR Intensities» увімкнено 

2. Compute → Vibrations 

✓ Дочекайтесь розрахунку (1–2 хв) 

Увага! Якщо з’явилось попередження про нестабільність 

структури — необхідно повторити оптимізацію або змінити 

вихідну геометрію. 

 

4. Перегляд та аналіз спектру 

1. У вікні Vibrations натисніть Display. 

2. Відкриється графік із вказаними частотами (в см⁻¹) та 

інтенсивностями. 



63 

3. Клацніть на будь-яку частоту → з'явиться анімація 

відповідного нормального коливання (молекула починає 

"дихати"). 

4. Занотуйте основні частоти: 

✓ Валентні коливання C=O: ~1700 см⁻¹ 

✓ Коливання CH: ~2800–3000 см⁻¹ 

 

5. Збереження результатів 

1. File → Save As → Acetone_IR.hin 

2. File → Export Picture → збережіть зображення графіка. 

3. У вікні Vibrations → Report → Save As .txt (частоти та 

інтенсивності). 

 

Звітність: 

У звіті мають бути: 

✓ Назва досліджуваної молекули 

✓ Метод оптимізації (PM3 або AM1) 

✓ Знімок спектра (IR-профіль) 

✓ Таблиця основних частот і типів коливань 

✓ Коментар щодо спостережених піків 

 

Завдання для студентів 

1. Провести аналогічний розрахунок для: 

o Етанолу 

o Аніліну 

o Бензойної кислоти 

2. Визначити: 

o Частоти валентних коливань O–H або N–H 

o Особливості коливань ароматичного циклу 

 
Індивідуальні завдання (на вибір): 

1. Побудуйте таблицю: порівняння частот для CH₃-груп у 

трьох молекулах. 

2. Визначте, як зміна функціональної групи впливає на 

частоту C=O. 
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Відправте файли виконаної лабораторної роботи на е-пошту 

викладача, у темі листа обов’язково вказіть прізвище та номер 

лабораторної роботи. 

 

4. Презентація підготовлених повідомлень здобувачами 

вищої освіти 

За бажанням оберіть запропоновану тему повідомлення з 

теми, яку вивчаєте. Підготуйте усний виступ та електронну 

презентацію з теми. Будьте готові виступити перед аудиторією. 

Теми повідомлень: 

ІЧ-спектроскопія: теоретичні основи та застосування в аналізі 

органічних речовин. 

Ідентифікація функціональних груп за допомогою ІЧ-спектрів. 

Квантово-хімічні методи розрахунку спектрів у HyperChem. 

Валентні й деформаційні коливання: розподіл по частотах. 

Застосування ІЧ-спектроскопії в фармацевтиці та органічному 

синтезі. 

Конформаційний аналіз органічних молекул: як знайти найбільш 

стабільну форму. 

Сучасні можливості HyperChem для навчання і досліджень: 

переваги й обмеження. 

Порівняння HyperChem із іншими програмами для моделювання 

(Chem3D, Avogadro, Gaussian View). 

 

Рекомендована література 

Основна: 

1. Bienz S. Short Manual to the Chemical Drawing Program 

ChemDraw / S. Bienz. University of Zurich. 2013. – 22 p. 

2. Олексеюк С.Т., Проц Д.І., Супрунович С.В. Прикладні 

комп’ютерні програми для аналітичної та органічної хімії. – 

Луцьк: РВВ „Вежа” ВДУ ім. Лесі Українки, 2004, – Ч.І. – 82 с. 

3. Бондар О.С. Практикум з комп’ютерної хімії. Навчальний 

посібник. Чернігів: ЧНПУ, 2017. – 68 с. 

4. Туровський М.А., Туровська О. М. Практичний курс 

комп’ютерної структурної хімії. Навчальний посібник. Донецьк: 

ДонНУ, 2004. 131 с. 
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Додаткова: 

1. Туровська О. М. Практикум з квантової хімії. Навчально-

методичний посібник / О. М. Туровська, М.А. Туровський. 

Донецьк: ДонНУ, 2007. – 81 с. 

2. Коновалова С.О. Комп’ютерні та інформаційні технології в 

хімії: стислий конспект лекцій. – Краматорськ: ДДМА, 2020. – 80 

с. 

3. Кулігін М.Л. Комп’ютерна хімія: конспект лекцій. – Херсон: 

ХНТУ, 2013. – 80 с. 

 

 

 

 

 

Дата                                                      Підпис викладача 
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Лабораторна робота №11 

Тема: Розрахунок енергії та оптимізація геометрії органічної 

молекули за допомогою Gaussian. 

Мета: Навчитися створювати молекулярні моделі в 

середовищі GaussView, експортувати їх до Gaussian, запускати 

базові квантово-хімічні розрахунки оптимізації геометрії та 

повної енергії, інтерпретувати результати. Зрозуміти роль 

функціоналу та базисного набору у розрахунках. 

Основні поняття: Gaussian, GaussView, оптимізація 

геометрії, SCF (Self-Consistent Field), Basis Set (базисний набір), 

DFT (Density Functional Theory). 

План заняття: 

1. Організаційний момент. 

2. Тестовий контроль знань здобувачів вищої освіти. 

3. Теоретичне опитування за планом самостійної роботи. 

4. Виконання лабораторної роботи. 

5. Презентація підготовлених повідомлень здобувачами вищої 

освіти. 

Інструкція до виконання: 

1. Тестовий контроль знань 

Опрацюйте запропоновані літературні джерела та 

підготуйтесь до індивідуального тестування за основними 

поняттями теми. 

2. Теоретичне опитування за планом самостійної роботи 

Самостійно опрацюйте запропоновані контрольні 

запитання/завдання та підготуйтеся до усного виступу та 

співбесіди за ними. 

Контрольні запитання/завдання  

1. Яка мета геометричної оптимізації в Gaussian? 

2. Що таке базисний набір і як він впливає на точність? 

3. Чим відрізняються методи HF, DFT, MP2? 

4. Як перевірити, чи розрахунок завершився коректно? 

5. Яке значення має відсутність уявних частот? 

 

3. Виконання лабораторної  роботи 

1. Побудова моделі молекули 
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Розглянемо на прикладі: молекула бензойної кислоти 

 

1. Відкрийте GaussView 

2. File → New → Create Molecule 

3. За допомогою інструментів Builder побудуйте: 

✓ бензольне кільце → додайте COOH-групу у пара-

положення 

✓ перевірте валентності 

4. Tools → Add Hydrogens 

5. File → Save As → benzoic.gjf 

 

2. Підготовка квантово-хімічного розрахунку 

1. У GaussView перейдіть до вкладки Calculation Setup 

2. Оберіть: 

✓ Job Type: Optimization 

✓ Method: DFT → B3LYP 

✓ Basis Set: 6-31G(d) 

3. У розділі Charge & Multiplicity: 

✓ Charge = 0 (нейтральна) 

✓ Multiplicity = 1 (синглет) 

4. Збережіть вхідний файл у форматі .gjf або .com 

 

3. Запуск Gaussian 

1. Запустіть Gaussian (можливо — через командний рядок: 

g16 < benzoic.gjf > benzoic.log) 

2. Дочекайтесь завершення розрахунку (перевірте файл .log) 

 

4. Аналіз результатів 

1. Відкрийте .log файл у GaussView: 

✓ Results → View Optimized Geometry → перевірте 

нову структуру 

✓ Results → Energy Plot → отримайте значення 

повної енергії 

2. Зверніть увагу: 

✓ Чи є “Converged?” 

✓ Чи відсутні imaginary frequencies? 
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5. Збереження та вивід результатів 

• Збережіть оптимізовану структуру як .xyz, .mol або .png 

• Зробіть скріншот вкладки «Summary» з основними даними 

• Запишіть значення: 

✓ Повної енергії 

✓ Дипольного моменту 

✓ Ентальпії (якщо задано) 

 

Завдання для студентів 

1. Проведіть аналогічний розрахунок для етанолу / аніліну / 

аспірину 

2. Змініть базис на 6-311++G(d,p) — порівняйте енергії 

3. Визначте, як зміна функціональної групи впливає на 

геометрію 

4. Створіть таблицю енергій для 5 молекул однієї 

гомологічної серії 

 

Відправте файли виконаної лабораторної роботи на е-пошту 

викладача, у темі листа обов’язково вказіть прізвище та номер 

лабораторної роботи. 

 

4. Презентація підготовлених повідомлень здобувачами 

вищої освіти 

За бажанням оберіть запропоновану тему повідомлення з 

теми, яку вивчаєте. Підготуйте усний виступ та електронну 

презентацію з теми. Будьте готові виступити перед аудиторією. 

Теми повідомлень: 

Огляд методів квантово-хімічного розрахунку в Gaussian 

Базисні набори: що це таке і як їх правильно обирати? 

DFT у хімії: принципи та переваги 

Gaussian як інструмент прогнозування структури речовин 

Особливості побудови вхідних файлів для Gaussian 

Роль геометричної оптимізації при моделюванні реакцій 

Чим відрізняються GaussView, HyperChem та Chem3D? 
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Рекомендована література 

Основна: 

1. Bienz S. Short Manual to the Chemical Drawing Program 

ChemDraw / S. Bienz. University of Zurich. 2013. – 22 p. 

2. Олексеюк С.Т., Проц Д.І., Супрунович С.В. Прикладні 

комп’ютерні програми для аналітичної та органічної хімії. – 

Луцьк: РВВ „Вежа” ВДУ ім. Лесі Українки, 2004, – Ч.І. – 82 с. 

3. Бондар О.С. Практикум з комп’ютерної хімії. Навчальний 

посібник. Чернігів: ЧНПУ, 2017. – 68 с. 

4. Туровський М.А., Туровська О. М. Практичний курс 

комп’ютерної структурної хімії. Навчальний посібник. Донецьк: 

ДонНУ, 2004. 131 с. 

Додаткова: 

1. Туровська О. М. Практикум з квантової хімії. Навчально-

методичний посібник / О. М. Туровська, М.А. Туровський. 

Донецьк: ДонНУ, 2007. – 81 с. 

2. Коновалова С.О. Комп’ютерні та інформаційні технології в 

хімії: стислий конспект лекцій. – Краматорськ: ДДМА, 2020. – 80 

с. 

3. Кулігін М.Л. Комп’ютерна хімія: конспект лекцій. – Херсон: 

ХНТУ, 2013. – 80 с. 

 

 

 

 

 

 

 

Дата                                                      Підпис викладача 

 

 

 

  



70 

Лабораторна робота №12 

Тема: Розрахунок інфрачервоного (ІЧ) спектру молекули за 

допомогою Gaussian. 

Мета: Навчитися виконувати квантово-хімічний розрахунок 

вібраційних частот у програмі Gaussian з використанням 

інтерфейсу GaussView, аналізувати отриманий ІЧ-спектр, 

інтерпретувати основні вібраційні моди та порівнювати їх із 

літературними даними.. 

Основні поняття: ІЧ-спектроскопія, нормальні коливання, 

вібраційний аналіз, уявні частоти. 

План заняття: 

1. Організаційний момент. 

2. Тестовий контроль знань здобувачів вищої освіти. 

3. Теоретичне опитування за планом самостійної роботи. 

4. Виконання лабораторної роботи. 

5. Презентація підготовлених повідомлень здобувачами вищої 

освіти. 

Інструкція до виконання: 

1. Тестовий контроль знань 

Опрацюйте запропоновані літературні джерела та 

підготуйтесь до індивідуального тестування за основними 

поняттями теми. 

2. Теоретичне опитування за планом самостійної роботи 

Самостійно опрацюйте запропоновані контрольні 

запитання/завдання та підготуйтеся до усного виступу та 

співбесіди за ними. 

Контрольні запитання/завдання  

1. Що означає уявна частота в ІЧ-розрахунку? 

2. Як змінюються частоти при переході від спирту до 

карбонової кислоти? 

3. Як впливають розмір і полярність на інтенсивність смуги? 

4. Які функціональні групи дають найбільш інтенсивні 

смуги? 

5. Як перевірити правильність структури після оптимізації? 

 

3. Виконання лабораторної  роботи 
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1. Побудова молекули в GaussView 

Розглянемо на прикладі молекули етанолу CH₃CH₂OH 

1. File → New → Create Molecule 

2. Інструментом Builder створіть: 

✓ CH₃—CH₂—OH 

3. Додайте всі гідрогени (Tools → Add Hydrogens) 

4. File → Save As → ethanol_IR.gjf 

 

2. Налаштування розрахунку 

1. У меню Calculation Setup: 

✓ Job Type: Frequency 

✓ Method: DFT → B3LYP 

✓ Basis Set: 6-31G(d) 

2. Charge = 0, Multiplicity = 1 

3. Включіть галочку "Compute Raman Intensities" 

(опційно) 

4. Збережіть файл: ethanol_IR.gjf 

 

3. Запуск розрахунку 

✓ Запустіть Gaussian (можливо — через командний рядок:  

g16 < ethanol_IR.gjf > ethanol_IR.log) 

✓ Дочекайтесь завершення (розрахунок триває ~2–5 хв для 

простої молекули) 

 

4. Перегляд результатів 

1. Відкрийте ethanol_IR.log через GaussView 

2. Results → Vibrations 

✓ Перегляньте список частот (в см⁻¹) 

✓ Увімкніть анімацію кожного коливання 

(натискайте на частоти) 

3. Display → IR Spectrum 

✓ Побачите симульований ІЧ-спектр 

 

5. Аналіз результатів 

Зверніть увагу на: 

• Відсутність imaginary frequencies → структура стабільна 
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• Частоти: 

✓ ~3600 см⁻¹ — валентне коливання O–H 

✓ ~2900 см⁻¹ — C–H 

✓ ~1100 см⁻¹ — C–O 

• Інтенсивності (чим вище пік — тим сильніше поглинання) 

 

6. Збереження результатів 

1. Збережіть: 

✓ Спектр: Export IR spectrum (.csv / .png) 

✓ Скріншоти анімації нормальних мод 

✓ Оптимізовану структуру (ethanol_IR.log) 

 

Оформлення звіту: 

У звіті повинні бути: 

✓ Зображення/файл ІЧ-спектру 

✓ Коментар: що ідентифікує спектр 

✓ Порівняння з літературними значеннями (за SDBS, Wiley IR 

Atlas тощо) 

 

Завдання для студентів 

1. Провести ІЧ-розрахунок для: 

➢ бензойної кислоти 

➢ ацетону 

➢ формальдегіду 

2. Пояснити появу характерних смуг (C=O, O–H, N–H, NO₂ 

тощо) 

3. Побудувати таблицю частот та інтенсивностей для кількох 

гомологів 

4. Порівняти ІЧ-спектри із базами даних 

 

Відправте файли виконаної лабораторної роботи на е-пошту 

викладача, у темі листа обов’язково вказіть прізвище та номер 

лабораторної роботи. 

 

4. Презентація підготовлених повідомлень здобувачами 

вищої освіти 
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За бажанням оберіть запропоновану тему повідомлення з 

теми, яку вивчаєте. Підготуйте усний виступ та електронну 

презентацію з теми. Будьте готові виступити перед аудиторією. 

Теми повідомлень: 

Принципи симульованої ІЧ-спектроскопії у квантовій хімії 

Порівняння ІЧ-розрахунків у HyperChem та Gaussian 

ІЧ-спектри спиртів, кислот, кетонів: порівняльний аналіз 

Метод B3LYP у DFT: переваги для вібраційних розрахунків 

Використання ІЧ-спектрів для ідентифікації невідомих речовин 

 

Рекомендована література 

Основна: 

1. Bienz S. Short Manual to the Chemical Drawing Program 

ChemDraw / S. Bienz. University of Zurich. 2013. – 22 p. 

2. Олексеюк С.Т., Проц Д.І., Супрунович С.В. Прикладні 

комп’ютерні програми для аналітичної та органічної хімії. – 

Луцьк: РВВ „Вежа” ВДУ ім. Лесі Українки, 2004, – Ч.І. – 82 с. 

3. Бондар О.С. Практикум з комп’ютерної хімії. Навчальний 

посібник. Чернігів: ЧНПУ, 2017. – 68 с. 

4. Туровський М.А., Туровська О. М. Практичний курс 

комп’ютерної структурної хімії. Навчальний посібник. Донецьк: 

ДонНУ, 2004. 131 с. 

Додаткова: 

1. Туровська О. М. Практикум з квантової хімії. Навчально-

методичний посібник / О. М. Туровська, М.А. Туровський. 

Донецьк: ДонНУ, 2007. – 81 с. 

2. Коновалова С.О. Комп’ютерні та інформаційні технології в 

хімії: стислий конспект лекцій. – Краматорськ: ДДМА, 2020. – 80 

с. 

3. Кулігін М.Л. Комп’ютерна хімія: конспект лекцій. – Херсон: 

ХНТУ, 2013. – 80 с. 

 

 

Дата                                                      Підпис викладача 
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Лабораторне заняття №13 

Тема: Модульна контрольна №2 «Пакети програм 

СhemOffice та HyperСhem, їх застосування» 

 

Обсяг вимог визначається програмою 
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Модуль 3. Графічне відображення даних з використанням 

пакета програм Origin. 

Лабораторна робота №14 

Тема: Візуалізація експериментальних даних за допомогою 

графічного математичного програмного пакету Origin. 

Мета: навчитися будувати графіки за табличними даними та 

оформлювати атрибути графіків: підписи, легенди, координати 

осей, властивості координатної сітки.  

Основні поняття: графік, лінійна апроксимація, візуалізація 

даних, легенда графіка, координатна сітка. 

План заняття: 

1. Організаційний момент. 

2. Тестовий контроль знань здобувачів вищої освіти. 

3. Теоретичне опитування за планом самостійної роботи. 

4. Виконання лабораторної роботи. 

5. Презентація підготовлених повідомлень здобувачами вищої 

освіти. 

Інструкція до виконання: 

1. Тестовий контроль знань 

Опрацюйте запропоновані літературні джерела та 

підготуйтесь до індивідуального тестування за основними 

поняттями теми. 

2. Теоретичне опитування за планом самостійної роботи 

Самостійно опрацюйте запропоновані контрольні 

запитання/завдання та підготуйтеся до усного виступу та 

співбесіди за ними. 

Контрольні запитання/завдання  

1. Яке значення має логарифмування експериментальних 

даних при побудові графіків? 

2. Як у Origin задати назви стовпців, одиниці вимірювання та 

легенду? 

3. Що означає перетворення 1000/Т в контексті 

термодинамічних графіків? 

4. Як змінити параметри осей (крок, діапазон, підпис)? 

5. Для чого будують графіки у форматі Symbol та Line + 

Symbol одночасно? 
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3. Виконання лабораторної  роботи 

Теоретичні відомості 

Інтерфейс користувача останніх версій Origin близький до 

загальноприйнятих стандартів Windows та складається з «Рядка 

заголовку», «Головного меню» та «Панелі інструментів». 

 
Після запуску графічного пакету Origin автоматично 

створюється новий проект, а на робочому полі відкривається 

вікно робочої таблиці, якій програма автоматично надає ім'я 

Book1. Його можна змінити під час її збереження. Для цього 

потрібно натиснути праву кнопку на назві та обрати пункт 

Rename для заміни стандартного імені на бажане. 

Вікно робочої таблиці Workbook – одне із багатьох робочих 

вікон у середовищі Origin, основне призначене якого це введення 

числових даних.  

Користувачеві доступні для створення і інших типів файлів: 

• Graph – візуалізація графіків; 

• Projekt – створення нового проекту; 

• Layout– створення нового шару; 

• Excel– меню програми Excel; 
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• Matrix – вікно завдання матриці; 

• Notes – вікно приміток. 

Усі створені або відкриті робочі вікна у проекті можна 

одночасно переглядати у вікні провідника Project Explorer для 

ввімкнення якого скористайтеся пунктом меню View. Можна 

зберігати як весь проект, так і окремі робочі вікна. У таблиці 

представлено відповідність розширення файлів типу робочого 

вікна. 

Тип вікна Розширення файлу 

Project (проект) OPJ 

Graph (візуалізація графіків) OGG 

Worksheet (вікно даних) OGW 

Excel (вікно та меню Excel) XLS 

Matrix (вікно завдання матриці) OGM 

Function (побудова графіка 

заданої функції) 
OGG 

Notes (вікно приміток) ТXT 

 

Для зручності сортування робочих вікон всередині проекту 

можна створювати окремі папки через меню «New Folder». 

Робочі вікна можна зробити активними та відображати на 

робочому полі або приховати та показувати тільки в провіднику. 

Для цього потрібно для необхідного вікна натиснути праву 

кнопку та вибрати пункт «Hide». 

Введення даних з клавіатури 

Для введення числових значень до таблиці даних Workbook 

достатньо встановити курсор в необхідному місці таблиці та 

клацнути лівою кнопкою миші та розпочинати введення даних з 

клавіатури. 

Додавання нової колонки 

За замовчуванням Origin створює таблицю з двома стовпцями 

А (Х) та В (Y). Для додавання додаткового стовпця необхідно 

натиснути праву кнопку миші на сірій області робочого вікна 

Workbook та вибрати пункт «Add New Column» .  

Властивості стовпців 
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По замовчуваню перший стовпець відповідає осі X, а кожен 

наступний осі Y про це можна змінити. Для цього потрібно 

виділити стовпець, який цікавить, натиснути праву кнопку миші 

та вибрати пункт Properties в якому і можна виконати необхідні 

зміни. Для проведення обчислень за відомими математичними 

формулами необхідно виділити діапазон даних, що цікавить, і 

відкрити діалогове вікно Set Column Values. 

 
 

Побудова графіка у робочому вікні Graph. 

 

Користувачам доступно декілька способів побудови графіків. 

Розглянемо випадок побудови через робочу таблицю. Для 

побудови графіка за введеними експериментальними даними 

необхідно виділити потрібний діапазон даних а в меню обрати 

команду «Plot» та натиснути 

✓ Line – лінія проводиться лише між точками;  

✓ Scatter –  відображаються лише експериментальні точки; 

✓ Line + Symbol – відображаються експериментальні точки 

та проводиться по них лінія. 
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На екрані з'явиться вікно Graph із зображенням побудованого 

графіка. 

Властивості та оформлення графіка 

Більшість операцій з графіками розпочинається подвійним 

натискання лівої кнопки миші на ньому. 

Щоб змінити властивості лінії побудованого графіка 

необхідно обрати пункт меню Plot Details. Для цього потрібно 

обрати головне меню – Format – Plot Properties або подвійне 

натискання лівою кнопкою миші на графіку. 

У вкладці «Line» можна змінити такі властивості лінії: тип 

лінії у вкладці «Plot type», обрати стиль лінії через «Style» 

(доступні різні комбінації штрихів, ліній та точок), товщину лінії 

у «Width», а також колір лінії графіка «Color». Помітка «Fill Area 

Under Curve» (зафарбовувати область під лінією) дозволяє 

заливати область під лінією тоновим кольором. 

У випадаючому списку «Connect» наявні такі варіанти 

з'єднання точок на графіку: 

• «No Line» (немає лінії) – точки не з'єднуватимуться; 

• «Straight» (пряма) – точки на графіку будуть з'єднані 

прямими лініями; 

• «2 Point segment» (двоточковий відрізок) – обрані 

точки з'єднуватимуться попарно відрізками;                            

• «3 Point segment» (трьохточковий відрізок) – графік 

буде розбитий на області по 3 точки; 

• «B-spline» (апроксимація з врахуванням розкиду) – по 

точках буде проведено лінію, що апроксимуватиме їх 

з врахуванням розкиду; 

• «Spline» (апроксимація) – по точках буде проведено 

лінію, що апроксимуватиме їх без врахуванням 

розкиду; 

• «Step horz» (крок по горизонталі), «Step vert» (крок по 

вертикалі) та «Step center» (крок по центру) – точки 

будуть з'єднані ступінчастими лініями. 

• «Bezier» (лінія Без'є) – по точках проводиться лінія, що 

апроксимує їх з використанням алгоритму Безье. 
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Для застосування змін потрібно натиснути «Apply», щоб 

переглянути результат без закриття діалогового вікна. Якщо 

результат буде незадовільний, то можна продовжити роботу в 

даному вікні до отримання потрібного вигляду графіка, а після 

цього натиснути «ОК». 

 
 

Оформлення координатних осей 
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Для редагування осей потрібно двічі клацнути на осі графіка 

лівою кнопкою миші. З'явиться вікно, яке дозволить змінити різні 

параметри: 

 

Scale 

Встановлення шкали координат.  

Ця вкладка використовується для вибору 

вертикальної або горизонтальної осей, 

встановлення шкали від початкового до кінцевого 

значення з певним типом: лінійним, 

логарифмічним, логічним. 

Title&For

mat 

Вкладка заголовку та форматування.  

Моожна обирати тип, ширину, стиль запису осі 

координат. 

Grid 

Lines 

Вкладка координатної сітки.  

Вибір горизонтальних та вертикальних 

додаткових або основних осей, їх кольору та типу. 

Break 

Вкладка вибору вертикальних та горизонтальних 

розривів.  

Можна використовувати, якщо експериментальні 

дані відрізняються один від одного на кілька 

порядкі. 

Tick 

Labels 

Вкладка міток на осях.  

Тут можна встановити колір міток, їх положення, 

формат, розмір 

Minor 

Tick 

Labels 

Додаткові мітки осей.  

Додаткові можливості оформлення міток. 

Custom 

Tick 

Labels 

Мітки осей.  

Поворот назв, додавання міток користувачем, 

центрування написів 

 

Встановлення інтервалу координатної осі 

Натиснувши двічі на координатній очі лівою кнопкою миші 

відкрити вкладку «Scale», де можна обрати для якої осі 

горизонтальної Horizontal (X) або вертикальної Vertical (Y) буде 

встановлюватися розмір шкали. В поле From ввести початкове 
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значення, а в поле To кінцеве значення шкали. Також можна 

ввести крок «Increment» по якому на шкалі будуть відображатися 

числові значення. 

Кількість штрихів на осі можна встановити через поле 

«Major Ticks» , а додаткові штрихи в полі «Minor Ticks». 

Штрихування та підпис осі 

У вкладці «Title&Format» можна ввести назву осі, її 

розташування, колір та формат штрихів. Для цього обирається 

потрібна вісь: позначка «Show Axis&Ticks» – показує вісь та 

штрихування; колір осі можна обрати у списку «Color»; товщину 

у – «Thickness», а довжину штрихів на осі у списку «Major Tick». 

Існує можливість створення назви кожної осі в полі «Title» 

через натискання «Format» на головне меню – Axis Titles – X Axis 

Title. 

Оформлення легенди графіка 

Подвійне натискання за легендою графіка відриває меню 

властивостей легенди, де можна змінити межі, заливку, шрифт, 

розмір, колір, назву легенди.  

Вставка графіків з Origin до Word або PowerPoint 

Для вставки побудованого графіка до Word або PowerPoіnt 

необхідно обрати потрібний графік, далі у меню «Edit» вибрати 

«Copy Page» та вставляти графік у документ. 

Зверніть увагу, що якщо після вставки графіка необхідно 

внести до нього зміни, то просто двічі натисніть лівою кнопкою 

миші на графіку прямо в документі Word або PowerPoіnt і якщо 

на комп'ютері встановлено Origin, він автоматично відкриється і 

графік можна буде відредагувати. 

 

Увага! Якщо українські написи НЕ відображається 

адекватно, то потрібно виділити запис та обрати шрифт кирилицю 

(Arial Cyr, Times New Roman Cyr). 

 

Завдання до лабораторної роботи: 

Візуалізуйте одержані в результаті експериментальних 

досліджень дані щодо залежності швидкості хімічного 
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розчинення твердого тіла від температури за допомогою 

графічного програмного пакету Origin. 

 

Т, К 

Vрозч. 

CdHgTe 

за 3 хвилини, мкм/хв 

Vрозч. 

СdTe 

за 3 хвилини, мкм/хв 

285 7,5 9,5 

289 8,5 10,5 

293 10,25 12,5 

297 11,25 14,5 

301 13 16 

 

1. Обрахуйте швидкість хімічного розчинення за 1 хвилину. 

2. Відкрийте Origin та створіть новий проект з назвою 

«Лабораторна_6_Прізвище студента» (наприклад 

«Лабораторна_6_Чайка») 

3. У створеному проекті додайте нове вікно Excel через File – 

New – Excel.  

4. У створеному вікні Excel додайте дані з таблиці 

експериментальних даних та проведіть обрахунки: 

- швидкості розчинення за 1 хвилину. 

- у наступній колонці знайдіть ln (V) 

- у наступній - 1000/Т. 

5. У вікні Book1 стовбець А(Х) заповніть даними з колонки 

1000/Т, а стовбець B (Y) відомостями щодо ln (V) зразків 

CdHgTe. 

6. Додайте ще один стовбець С(Y) та заповніть його даними 

щодо ln (V) зразків CdTe. 

7. Дайте назви стовбцям у рядку «Long name». 

8. Розмірності величин внесіть у «Units» для кожного зі 

стовбців. 

9. Побудуйте окремо графіки залежності ln (V) від 1000/Т для 

CdHgTe та CdHgTe (вид Line + Symbol) та для обох кристалів 

разом з типом Symbol. Увага! Всього графіків повинно бути 3.  

10. У створених графіках оберіть ціну поділки осі Y – 0,2 

мкм/хв, а осі Х – 0,15.   
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11. Колір ліній для CdHgTe – червоний, CdTe – синій. 

12. У об’єднаному графіку (тип Symbol) самостійно за 

допомогою інструменту «Лінія» покажіть залежність ln (V) від 

1000/Т. Встановіть для кожної кристалу відповідний колір. 

Оберіть варіант з'єднання точок на графіках з типом «Line + 

Symbol» -  B-spline. 

13. Для всіх графіків повинні бути обрані наступні параметри: 

товщина ліній осей – 1; ліній на графіку – 1,5. Шрифт – Arial, 

розмір для підпису осей – 28 пт, напівжирний; розмір для підпису 

ціни поділки 25 пт, нежирний. Пунктири з діленням осей назовні.  

14. Створіть новий документ Word з назвою – 

Лабораторна_6_прізвище ім’я (Лабораторна_6_Чайка Микола).  

Вставте побудовані графіки до Word. Для цього перейдіть у вікно 

потрібного графіку, далі у меню «Edit» оберіть «Copy Page». 

15. Збережіть створений проект Origin. 

 

Усі створені або відкриті Вами вікна у проекті можна 

одночасно переглядати у вікні провідника Project Explorer для 

ввімкнення використайте меню View. 

 

Відправте файли виконаної лабораторної роботи на е-пошту 

викладача, у темі листа обов’язково вказіть прізвище та номер 

лабораторної роботи. 

Увага у доданій папці з вашим ПІП повинно бути документ 

Word з 3 графіками та  файл проекту Origin, в якому Ви 

виконували завдання. 

 

За відсутності пакету програм Origin лабораторну роботу 

можна виконувати в Excel. 

 

4. Презентація підготовлених повідомлень здобувачами 

вищої освіти 

За бажанням оберіть запропоновану тему повідомлення з 

теми, яку вивчаєте. Підготуйте усний виступ та електронну 

презентацію з теми. Будьте готові виступити перед аудиторією. 
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Теми повідомлень: 

Програма Origin: базові можливості та інтерфейс користувача 

Типи графіків у Origin: коли і який доцільно використовувати? 

Вплив точності вхідних даних на вигляд апроксимації 

Порівняння візуалізації в Origin та Excel 

Професійне оформлення графіків для наукових публікацій 

Особливості побудови мультисерійних графіків 

Математичні операції у вікні таблиці Origin. 

 

Рекомендована література 

Основна: 

1. Олексеюк С.Т., Проц Д.І., Супрунович С.В. Прикладні 

комп’ютерні програми для аналітичної та органічної хімії. – 

Луцьк: РВВ „Вежа” ВДУ ім. Лесі Українки, 2004, – Ч.І. – 82 с. 

2. Бондар О.С. Практикум з комп’ютерної хімії. Навчальний 

посібник. Чернігів: ЧНПУ, 2017. – 68 с. 

3. Туровський М.А., Туровська О. М. Практичний курс 

комп’ютерної структурної хімії. Навчальний посібник. Донецьк: 

ДонНУ, 2004. 131 с. 

Додаткова: 

1. Jensen F. Introduction to Computational Chemistry. – London, 

1999. – 429. 

2. Коновалова С.О. Комп’ютерні та інформаційні технології в 

хімії: стислий конспект лекцій. – Краматорськ: ДДМА, 2020. – 80 

с. 

3. Кулігін М.Л. Комп’ютерна хімія: конспект лекцій. – Херсон: 
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Лабораторна робота №15 

Тема: Аналіз та візуалізація хімічних даних за допомогою 

програмного забезпечення Origin. 

Мета: Навчитися працювати з табличними даними у Origin; 

виконувати обчислення на основі експериментальних даних; 

візуалізувати результати у вигляді графіків та діаграм; 

аналізувати залежності та тенденції хімічних процесів.  

Основні поняття: табличні дані, графік розчинності, лінійна 

апроксимація, лінія тренду, константа швидкості реакції, графік 

кінетичної залежності, енергія активації, інтегрування даних. 

План заняття: 

1. Організаційний момент. 

2. Тестовий контроль знань здобувачів вищої освіти. 

3. Теоретичне опитування за планом самостійної роботи. 

4. Виконання лабораторної роботи. 

5. Презентація підготовлених повідомлень здобувачами вищої 

освіти. 

Інструкція до виконання: 

1. Тестовий контроль знань 

Опрацюйте запропоновані літературні джерела та 

підготуйтесь до індивідуального тестування за основними 

поняттями теми. 

2. Теоретичне опитування за планом самостійної роботи 

Самостійно опрацюйте запропоновані контрольні 

запитання/завдання та підготуйтеся до усного виступу та 

співбесіди за ними. 

Контрольні запитання/завдання  

1. Який принцип побудови графіка ln(C) vs 1/T? 

2. Як інтерпретувати нахил прямої в лінійній апроксимації? 

3. Які залежності характерні для реакцій другого порядку? 

4. Яка фізична суть показника λ⁰ у електропровідності? 

5. Які критерії оцінки якості апроксимації у Origin? 

6. Які переваги має використання Isis Draw у наукових 

публікаціях? 

7. Як вставити структурну формулу в документ Word або 

презентацію? 
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3. Виконання лабораторної  роботи 

1. Побудова графіка розчинності речовин у воді в 

залежності від температури: 

T (°C) C (г/л) 

0 35.7 

10 36.8 

20 37.5 

30 38.1 

40 38.8 

50 39.5 

60 40.1 

70 40.6 

80 41.2 

90 41.7 

100 42.3 

 

1. Відкрийте Origin та створіть новий проект під назвою 

"Лабораторна_X_Прізвище". 

2. Введіть або імпортуйте дані про розчинність речовини X у 

воді при різних температурах. 

3. Додайте нову колонку для обчислення логарифму 

розчинності (ln C). 

4. Побудуйте графік залежності ln C від 1/T. 

5. Використайте метод лінійної апроксимації для визначення 

енергії активації процесу розчинення. 

Для цього натисніть → Analysis > Fitting > Linear Fit > натіснь OK 

 
Origin згенерує таблицю результатів, з якої зверніть увагу на 

значення Slope. 

За кутом нахилу прямої визначте уявну енергію активації 

процесу розчинення, для цього використайте формулу:  

Еа= -R ⋅ а,  
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де а – значення нахилу прямої (Slope), R – універсальна газова 

стала. 

Припускають, що Еа для процесів, що лімітуються стадією 

дифузії, не перевищує 30 кДж·моль–1, тоді як Еа процесів 

розчинення, що обмежуються швидкістю хімічної реакції, може 

значно перевищувати 30 кДж/моль. 

6. Оформіть графік, додавши легенду, мітки осей та підписи. 

7. В документ Word вставте отриманий графік а також 

розрахунки значення енергії активації процесу 

розчинення. 

 

2. Аналіз кінетики реакції другого порядку: 

Час (с) [A] (моль/л) 

0 0.100 

10 0.083 

20 0.071 

30 0.062 

40 0.055 

50 0.050 

60 0.045 

1. Введіть експериментальні дані про зміну концентрації 

реагенту з часом. 

2. Додайте колонку для обчислення 1/[A] (зворотна 

концентрація). 

3. Побудуйте графік залежності 1/[A] від часу. 

4. Визначте константу швидкості реакції та порівняйте з 

теоретичними значеннями. 

Константа швидкості k чисельно дорівнює нахилу графіка 

1/[A] від часу, для розрахунку: 

а) виберіть дві точки (t1,1/[A]1) та (t2,1/[A]2)  на прямій. 

б) підставте у формулу:  
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в) знайдіть в літературі теоретичне значення константи 

швидкості реакції другого порядку та порівняйте з розрахованим 

значенням. 

5. Оформіть графік, додавши легенду, мітки осей та підписи 

6. В документ Word вставте отриманий графік а також 

розрахунки значення константи швидкості реакції та її 

порівняння з теоретичним значенням. 

  

3. Визначення теплового ефекту хімічної реакції: 

Час (с) Температура (°C) 

0 25.0 

10 27.3 

20 29.1 

30 30.5 

40 31.8 

50 32.9 

60 33.8 

 

1. Використайте експериментальні дані калориметричного 

дослідження. 

2. Побудуйте графік зміни температури системи в залежності 

від часу. 

3. Використовуючи інтегрування даних, визначте кількість 

теплоти, що виділилася у процесі реакції. 

Для визначення кількості теплоти, що виділилася у процесі 

реакції: 

а) обчисліть Δ𝑇, як різницю між Tкінц та Tпоч 

б) визначіть теплоємність системи, для цього припустимо, що 

система — це 100 г води, а вода має питому теплоємність 𝑐 = 4,18 

  Дж/(г∙℃), тоді 

C=m⋅c=100⋅4.18=418 Дж/°C 

в) розрахуйте кількість теплоти за формулою  𝑞 = 𝐶 ⋅ Δ𝑇  

4. Оформіть графік, додавши легенду, мітки осей та підписи. 
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5. В документ Word вставте отриманий графік а також 

розрахунки кількості теплоти, що виділилася у процесі 

реакції. 

 

4. Дослідження електропровідності розчинів солей: 

C (моль/л) λ (См·м²/моль) 

0.01 125.6 

0.02 118.3 

0.05 110.5 

0.10 102.8 

0.20 95.6 

0.50 85.2 

 

1. Внесіть в Origin дані про електропровідність різних 

концентрацій солей. 

2. Побудуйте графік залежності електропровідності від 

концентрації. Для цього по осі X використайте дані √С та 

λ – по осі Y. 

3. Використовуючи функцію "Fit", визначте модель 

залежності.  

Для цього натисніть → Analysis > Fitting > Linear Fit > натіснь 

OK 

Origin згенерує таблицю результатів, з якої зверніть увагу на 

Summary: 

 
Intercept (вільний член) = λ0 – гранична молярна 

електропровідність 

Slope (нахил) = k – коефіцієнт залежності 

R² (R-Square) – показує якість апроксимації (чим ближче до 

1, тим краще) 
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Якщо: R² ≈ 0.99 або вище, модель добре описує дані  – сіль є 

сильним електролітом, повністю дисоціює у розчині 

4. Зробіть висновки щодо механізму електропровідності у 

розчинах. 

5. Оформіть графік, додавши легенду, мітки осей та підписи. 

6. В документ Word вставте отриманий графік а також 

інформацію щодо механізму електропровідності. 

 

Оформлення результатів: 

1. Усі графіки повинні мати правильні підписи осей (Arial, 14 

пт), легенду та відповідне форматування. 

2. Використовуйте різні типи ліній та маркерів для 

покращення візуального сприйняття. 

3. Збережіть проект у форматі .OPJ. 

4. Вставте отримані графіки у документ Word та збережіть 

його під назвою "Лабораторна_X_Прізвище". 

 

Відправте файли виконаної лабораторної роботи на е-пошту 

викладача, у темі листа обов’язково вказіть прізвище та номер 

лабораторної роботи. 

 

За відсутності пакету програм Origin лабораторну роботу 

можна виконувати в Excel. 

 

4. Презентація підготовлених повідомлень здобувачами 

вищої освіти 

За бажанням оберіть запропоновану тему повідомлення з 

теми, яку вивчаєте. Підготуйте усний виступ та електронну 

презентацію з теми. Будьте готові виступити перед аудиторією. 

Теми повідомлень: 

Визначення енергії активації процесів розчинення: теорія та 

практика 

Кінетика хімічних реакцій другого порядку: методика аналізу 

даних 

Графічне представлення калориметричних вимірювань 

Механізм електропровідності та її графічна інтерпретація 
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Порівняння способів апроксимації у Origin 

Електронні таблиці Origin як інструмент аналізу даних в 

аналітичній хімії 

Побудова багатосерійних графіків для порівняльного аналізу. 

 

Рекомендована література 

Основна: 

1. Олексеюк С.Т., Проц Д.І., Супрунович С.В. Прикладні 

комп’ютерні програми для аналітичної та органічної хімії. – 

Луцьк: РВВ „Вежа” ВДУ ім. Лесі Українки, 2004, – Ч.І. – 82 с. 

2. Бондар О.С. Практикум з комп’ютерної хімії. Навчальний 

посібник. Чернігів: ЧНПУ, 2017. – 68 с. 

3. Туровський М.А., Туровська О. М. Практичний курс 

комп’ютерної структурної хімії. Навчальний посібник. Донецьк: 

ДонНУ, 2004. 131 с. 

Додаткова: 

1. Jensen F. Introduction to Computational Chemistry. – London, 

1999. – 429. 

2. Коновалова С.О. Комп’ютерні та інформаційні технології в 

хімії: стислий конспект лекцій. – Краматорськ: ДДМА, 2020. – 80 

с. 

3. Кулігін М.Л. Комп’ютерна хімія: конспект лекцій. – Херсон: 

ХНТУ, 2013. – 80 с. 

 

 

 

 

 

 

Дата                                                      Підпис викладача 
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Лабораторна робота №16 

Тема: Побудова 3D-графіків розчинності речовин у різних 

розчинниках. 

Мета: Навчитися представляти багатовимірні 

експериментальні дані за допомогою 3D-графіків у програмному 

середовищі Origin. Навчитись будувати 3D Surface Plot для 

порівняльного аналізу впливу температури та розчинника на 

розчинність речовини. 

Основні поняття: Тривимірні графіки (3D Surface Plot), 

матриця даних у Origin, колірна шкала (Color Mapping), глибина 

кольору (Z-вісь), рельєфна візуалізація (Shading), поверхня 

залежності, інтерполяція та сітка, легенда, осі, підписи. 

План заняття: 

1. Організаційний момент. 

2. Тестовий контроль знань здобувачів вищої освіти. 

3. Теоретичне опитування за планом самостійної роботи. 

4. Виконання лабораторної роботи. 

5. Презентація підготовлених повідомлень здобувачами вищої 

освіти. 

Інструкція до виконання: 

1. Тестовий контроль знань 

Опрацюйте запропоновані літературні джерела та 

підготуйтесь до індивідуального тестування за основними 

поняттями теми. 

2. Теоретичне опитування за планом самостійної роботи 

Самостійно опрацюйте запропоновані контрольні 

запитання/завдання та підготуйтеся до усного виступу та 

співбесіди за ними. 

Контрольні запитання/завдання  

1. Яку роль відіграє формат "матриці" в Origin при побудові 

3D-графіків? 

2. Які типи 3D-графіків існують у Origin і для яких даних 

вони застосовуються? 

3. Як змінити кольорову шкалу графіка? 

4. Як змінити кут огляду у тривимірному вікні? 
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5. Як проаналізувати, який розчинник найкраще розчиняє 

речовину? 

 

3. Виконання лабораторної  роботи 

1. Підготовка експериментальних даних 

Використайте наведені експериментальні дані щодо 

розчинності органічної сполуки X у різних розчинниках при 

зміні температури: 

Температура, 

°C 

Вода 

(г/л) 

Етанол 

(г/л) 

Ацетон 

(г/л) 

Хлороформ 

(г/л) 

20 35.0 18.2 7.1 5.0 

30 39.5 22.6 8.5 6.0 

40 43.7 25.8 9.4 7.2 

50 47.9 29.1 10.8 8.5 

60 52.2 32.7 12.0 9.8 

 

2. Запуск Origin і створення таблиці 

1. Відкрийте Origin 

2. Створіть новий проект: 

File → New Project 

3. Додайте матрицю: 

File → New → Matrix 

 

3. Введення даних у матрицю 

1. У Matrix в меню: Matrix → Set Dimensions: 

✓ Rows (X): 5 (Temp) 

✓ Columns (Y): 4 (Розчинники) 

2. В меню: Matrix → Set Values 

✓ У рядок заголовків введіть розчинники: Water, 

Ethanol, Acetone, Chloroform 

✓ У колонку зліва введіть температури: 20, 30, 40, 50, 

60 

✓ Заповніть саму матрицю значеннями розчинності 

 

4. Побудова 3D Surface Plot 

1. Виділіть всю матрицю 
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2. У меню натисніть Plot → 3D → Surface 

 

5. Налаштування графіка 

У вікні графіка: 

1. Клацніть двічі по Z-шкалі → Colormap / Contour: 

✓ Тип заливки: Smooth 

✓ Додати градієнт кольорів (наприклад, від синього 

до червоного) 

2. У меню Format Axes: 

✓ Підпишіть осі: 

➢ X — Температура (°C) 

➢ Y — Розчинник 

➢ Z — Розчинність (г/л) 

✓ Встановіть діапазон осей вручну, якщо потрібно 

3. У вкладці 3D View змініть: 

✓ Кут огляду 

✓ Рельєф — увімкнути 

✓ Відображення сітки — за бажанням 

 

6. Збереження результатів і створення звіту 

1. У меню File → Save Project As збережіть файл, наприклад: 

Lab_3D_Solubility_Yakymenko.opj 

2. У Word-документ вставте знімок графіка через: 

Edit → Copy Page → Paste у документі. 

3. У звіті вкажіть: 

✓ Формат вхідних даних 

✓ Тип побудованого графіка 

✓ Опис результату: в якому розчиннику зростання 

найбільш стрімке 

 

Оформлення результатів 

➢ Підписи осей шрифтом Arial, розмір 14 pt 

➢ Колірна шкала з лінійною інтерполяцією 

➢ Назва графіка напівжирним, розмір 16 pt 

➢ Виділити максимальну точку (опційно — червоним 

маркером) 
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Результати оформити у звіті 

Файл у форматі Word: Лабораторна_Прізвище_3DГрафік.docx 

Файл проекту: Lab_3D_Solubility_Прізвище.opj 

 

Відправте файли виконаної лабораторної роботи на е-пошту 

викладача, у темі листа обов’язково вказіть прізвище та номер 

лабораторної роботи. 

 

 

4. Презентація підготовлених повідомлень здобувачами 

вищої освіти 

За бажанням оберіть запропоновану тему повідомлення з 

теми, яку вивчаєте. Підготуйте усний виступ та електронну 

презентацію з теми. Будьте готові виступити перед аудиторією. 

Теми повідомлень: 

Типи тривимірних графіків у Origin: практичне застосування в 

хімії. 

Візуалізація багатофакторних експериментів: методи обробки. 

Інтерполяція та побудова поверхонь розчинності. 

Вплив температури на розчинність у різних середовищах. 

Порівняльна графічна візуалізація в Origin та Excel. 

 

Рекомендована література 

Основна: 

1. Bienz S. Short Manual to the Chemical Drawing Program 

ChemDraw / S. Bienz. University of Zurich. 2013. – 22 p. 

2. Олексеюк С.Т., Проц Д.І., Супрунович С.В. Прикладні 

комп’ютерні програми для аналітичної та органічної хімії. – 

Луцьк: РВВ „Вежа” ВДУ ім. Лесі Українки, 2004, – Ч.І. – 82 с. 

3. Бондар О.С. Практикум з комп’ютерної хімії. Навчальний 

посібник. Чернігів: ЧНПУ, 2017. – 68 с. 

4. Туровський М.А., Туровська О. М. Практичний курс 

комп’ютерної структурної хімії. Навчальний посібник. Донецьк: 

ДонНУ, 2004. 131 с. 

Додаткова: 

1. Туровська О. М. Практикум з квантової хімії. Навчально-
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методичний посібник / О. М. Туровська, М.А. Туровський. 

Донецьк: ДонНУ, 2007. – 81 с. 

2. Коновалова С.О. Комп’ютерні та інформаційні технології в 

хімії: стислий конспект лекцій. – Краматорськ: ДДМА, 2020. – 80 

с. 

3. Кулігін М.Л. Комп’ютерна хімія: конспект лекцій. – Херсон: 

ХНТУ, 2013. – 80 с. 

 

 

 

 

 

Дата                                                      Підпис викладача 
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Лабораторна робота №17 

Тема: Інтеграція хімічних структур і моделей з 

спеціалізованих редакторів у документи пакету MS Office. 

Мета: Опанувати навички імпорту хімічних структур, 

формул, 3D-моделей у документи Word, таблиці Excel, бази 

Access і презентації PowerPoint. Навчитися використовувати 

формати вставки: рисунок, об’єкт, вбудований документ, 

векторне зображення, **.cdx. 

Основні поняття: об’єкт OLE (Object Linking and 

Embedding), векторне зображення, растрове зображення, методи 

вставки, хімічні структури в презентаціях. 

План заняття: 

1. Організаційний момент. 

2. Тестовий контроль знань здобувачів вищої освіти. 

3. Теоретичне опитування за планом самостійної роботи. 

4. Виконання лабораторної роботи. 

5. Презентація підготовлених повідомлень здобувачами вищої 

освіти. 

Інструкція до виконання: 

1. Тестовий контроль знань 

Опрацюйте запропоновані літературні джерела та 

підготуйтесь до індивідуального тестування за основними 

поняттями теми. 

2. Теоретичне опитування за планом самостійної роботи 

Самостійно опрацюйте запропоновані контрольні 

запитання/завдання та підготуйтеся до усного виступу та 

співбесіди за ними. 

Контрольні запитання/завдання  

1. У чому переваги вставки *.cdx-файлів у Word? 

2. Які переваги вставки зображень у форматі *.emf у 

PowerPoint? 

3. Як зробити, щоб вставлений об’єкт ChemDraw у Word 

залишався редагованим? 

4. Яка різниця між об’єктом і рисунком в Office? 

5. Які недоліки вставки хімічних структур у Excel? 
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3. Виконання лабораторної  роботи 

 

1. Створення хімічної структури 

1. Відкрийте ChemDraw (або MarvinSketch, ChemSketch). 

2. Побудуйте 3 прості сполуки: 

✓ етанол (CH₃CH₂OH), 

✓ бензойна кислота, 

✓ ацетон. 

3. Збережіть кожну з них у форматі: 

✓ .cdx (для подальшого вставлення), 

✓ .png або .emf (для вставки як зображення). 

 

2. Вставка у Word 

1. Відкрийте MS Word → Вставка → Об’єкт → Обрати 

"ChemDraw Document" → вставити .cdx. 

2. Альтернатива: 

У ChemDraw: Edit → Copy → У Word: Paste 

Потім: Правою кнопкою → Редагувати об’єкт 

3. Вставте також структуру як зображення: 

✓ У ChemDraw: File → Export as PNG → Insert → 

Picture в Word. 

Порівняйте: що краще масштабовано, що можна редагувати? 

 

3. Вставка у Excel 

1. Вставте хімічні структури до Excel: 

✓ В одну клітинку — як рисунок (Insert → Picture). 

✓ В іншу — як об’єкт (Insert → Object → ChemDraw 

Document). 

2. Спробуйте вставити одну структуру до кількох рядків, 

щоб зберегти форму таблиці. 

3. Поясніть, чому *.emf краще ніж *.png для Excel. 

 

4. Вставка у PowerPoint 

1. Вставте побудовані структури у слайди PowerPoint: 

✓ З ChemDraw як рисунок, 

✓ Як активний об’єкт для редагування. 
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2. Створіть 1 слайд з порівнянням форматів: 

✓ *.cdx embedded 

✓ *.emf (вектор) 

✓ *.png (растровий) 

3. Додайте 3D-модель (з 3D Viewer) у форматі *.mol, *.pdb 

або *.jpg як ілюстрацію. 

 

5. Висновки та збереження 

• Збережіть результати роботи у файлах: 

✓ Word: "Інтеграція_Прізвище.docx" 

✓ Excel: "Хімічні структури.xlsx" 

✓ PowerPoint: "Презентація структур.pptx" 

 

Завдання для студентів: 

1. Побудова та збереження структур 

• Створіть у ChemDraw (або MarvinSketch / ChemSketch) 

структурні формули таких речовин: 

1. Етанол 

2. Бензойна кислота 

3. Аспірин 

• Збережіть кожну формулу у трьох форматах: 

o *.cdx (ChemDraw) 

o *.emf (векторне зображення) 

o *.png (растрове зображення) 

 

2. Вставка структур у Word 

• Відкрийте новий документ MS Word. 

• Вставте етанол: 

o як рисунок *.png 

o як об’єкт *.cdx (з можливістю редагування) 

• Вставте аспірин як *.emf з ChemDraw. 

• Створіть підписи до кожної структури (назва сполуки, 

формат вставки). 

• Збережіть файл як: Struktury_Word_Прізвище.docx 

 

3. Робота з Excel 



101 

• Створіть таблицю: 

Сполука Маса (г) Формула 
Тип 

вставки 

Етанол 46.07 (вставити 

структуру) 

EMF 

Бензойна 

кислота 

122.12 (вставити 

структуру) 

CDX 

Аспірин 180.16 (вставити 

структуру) 

PNG 

• Для кожної сполуки вставте хімічну формулу у відповідну 

клітинку. 

• Збережіть файл як: Struktury_Excel_Прізвище.xlsx 

 

4. Створення презентації в PowerPoint 

• Створіть 3 слайди: 

✓ Слайд 1 — заголовок і опис методів вставки 

✓ Слайд 2 — вставка трьох структур у різних 

форматах 

✓ Слайд 3 — порівняння якості масштабування *.emf 

vs *.png vs *.cdx 

• Застосуйте різні стилі оформлення, шрифти, тло. 

• Збережіть файл як: Struktury_PPT_Прізвище.pptx 

 

5. Порівняння форматів вставки 

• Створіть у Word таблицю з порівнянням: 

Формат 
Можливість 

редагування 

Якість 

масштабування 

Розмір 

файлу 

Рекомендоване 

використання 

*.cdx     

*.emf     

*.png     
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Відправте файли виконаної лабораторної роботи на е-пошту 

викладача, у темі листа обов’язково вказіть прізвище та номер 

лабораторної роботи. Звіт повинен містити приклади вставок 

структур (знімки екрана або самі об’єкти). Рекомендовано додати 

короткий аналіз переваг/недоліків кожного методу. 

 

 

4. Презентація підготовлених повідомлень здобувачами 

вищої освіти 

За бажанням оберіть запропоновану тему повідомлення з 

теми, яку вивчаєте. Підготуйте усний виступ та електронну 

презентацію з теми. Будьте готові виступити перед аудиторією. 

Теми повідомлень: 

Формати зображень у хімічній візуалізації: *.cdx, *.mol, *.emf, 

*.png 

OLE-об’єкти в MS Office: переваги та недоліки для хімії 

Порівняння ChemDraw, MarvinSketch і ChemSketch у 

презентаціях 

Вставка 3D-молекул у документи: варіанти і проблеми 

Хімічні документи в PowerPoint: як зберегти якість та 

масштабованість? 

 

Рекомендована література 

Основна: 

1. Bienz S. Short Manual to the Chemical Drawing Program 

ChemDraw / S. Bienz. University of Zurich. 2013. – 22 p. 

2. Олексеюк С.Т., Проц Д.І., Супрунович С.В. Прикладні 

комп’ютерні програми для аналітичної та органічної хімії. – 

Луцьк: РВВ „Вежа” ВДУ ім. Лесі Українки, 2004, – Ч.І. – 82 с. 

3. Бондар О.С. Практикум з комп’ютерної хімії. Навчальний 

посібник. Чернігів: ЧНПУ, 2017. – 68 с. 

4. Туровський М.А., Туровська О. М. Практичний курс 

комп’ютерної структурної хімії. Навчальний посібник. Донецьк: 

ДонНУ, 2004. 131 с. 

Додаткова: 

1. Туровська О. М. Практикум з квантової хімії. Навчально-
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методичний посібник / О. М. Туровська, М.А. Туровський. 

Донецьк: ДонНУ, 2007. – 81 с. 

2. Коновалова С.О. Комп’ютерні та інформаційні технології в 

хімії: стислий конспект лекцій. – Краматорськ: ДДМА, 2020. – 80 

с. 

3. Кулігін М.Л. Комп’ютерна хімія: конспект лекцій. – Херсон: 

ХНТУ, 2013. – 80 с. 

 

 

 

 

 

 

Дата                                                      Підпис викладача 

 

 

 

 

 

 

Лабораторне заняття №18 

Тема: Модульна контрольна №3 «Графічне відображення 

даних з використанням пакета програм Origin» 

 

Обсяг вимог визначається програмою 
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Рекомендована література 

Основна: 

1. Коновалова С.О. Комп’ютерні та інформаційні технології 

в хімії: стислий конспект лекцій. – Краматорськ: ДДМА, 

2020. – 80 с. 

2. Кулігін М.Л. Комп’ютерна хімія: конспект лекцій. – 

Херсон: ХНТУ, 2013. – 80 с. 

3. Бондар О.С. Практикум з комп’ютерної хімії. Навчальний 

посібник. Чернігів: ЧНПУ, 2017. – 68 с. 

4. Туровський М.А., Туровська О. М. Практичний курс 

комп’ютерної структурної хімії. Навчальний посібник. 

Донецьк: ДонНУ, 2004. 131 с 

5. Ракша О. В. Інформаційні технології у фізичній хімії: 

навчально-методичний посібник / О. В. Ракша. – Донецьк: 

ДонНУ, 2013. – 98 с. 

6. Олексеюк С.Т., Проц Д.І., Супрунович С.В. Прикладні 

комп’ютерні програми для аналітичної та органічної хімії. 

– Луцьк: РВВ „Вежа” ВДУ ім. Лесі Українки, 2004, – Ч.І. – 

82 с 

7. Туровська О. М. Практикум з квантової хімії. Навчально-

методичний посібник / О. М. Туровська, М.А. Туровський. 

Донецьк: ДонНУ, 2007. – 81 с. 

Додаткова 

1. ACD/ChemSketch. Version 2012 for Microsoft Windows. 

Drawing Chemical Structures and Graphical Images Tutorial. 

/ Advanced Chemistry Development, Inc. 2013. – 156 p. 

2. Bienz S. Short Manual to the Chemical Drawing Program 

ChemDraw / S. Bienz. University of Zurich. 2013. – 22 p. 

3. Гужва В.М. Інформаційні системи і технології на 

підприємствах : навч. посібник.- К: КНЕУ, 2001. - 400 с 

4. Jensen F. Introduction to Computational Chemistry. – London, 

1999. – 429. 

5. Leach A. Molecular Modelling. Principles and Applications. – 

Dorset, 2001. – 744. 

6. Неділько С.А. Математичні методи в хімії: Підручник. – 

К.: Либідь, 2005, 256 с. 
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Інтернет ресурси: 

1. Бібліотека Житомирського державного університету імені 

Івана Франка [Електронний ресурс] – режим доступу до 

ресурсу: http://irbis.zu.edu.ua 

2. Національна бібліотека України імені В.І.Вернадського 

Франка [Електронний ресурс] – режим доступу: 

http://nbuv.gov.ua 

3. Пакет програмного забезпечення ChemOffice, зокрема, 

графічний редактор хімічних формул ChemDraw – 

http://www.cambridgesoft.com 

4. ACD/ChemSketch Freeware for personal or academic use, 

пакет програмного забезпечення для малювання хімічних 

структур – http://www.acdlabs.com 

5. MarvinSketch редактор хімічних формул – 

http://www.chemaxon.com 

6. PubChem, відкрита база даних хімії Національного 

інституту охорони здоров'я (NIH)  

http://pubchem.ncbi.nlm.nih.gov 

7. ChemSpider, безкоштовна база даних хімічних структур – 

http://www.chemspider.com 

8. Organic Syntheses, база методик синтезу – 

http://www.orgsyn.org 

9. e-Molecules, онлайн ресурс пошуку інформації у власній 

базі даних ресурсу та провідних хімічних каталогах і базах 

даних властивостей хімічних сполук – 

https://www.emolecules.com 

 

http://irbis.zu.edu.ua/cgi-bin/irbis64r_11/cgiirbis_64.exe
http://nbuv.gov.ua/
http://www.cambridgesoft.com/
http://www.acdlabs.com/
http://www.chemaxon.com/
http://pubchem.ncbi.nlm.nih.gov/
http://www.chemspider.com/
http://www.orgsyn.org/
https://www.emolecules.com/

